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Troubleshooting

Troubleshooting

Troubleshooting information is categorized into two areas:

® Problem Resolution
® Error Messages
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Problem Resolution

® Problem Resolution
® Database
® |nstallation
® QOperations

Problem Resolution

This page provides links to problems, and their solutions, that you might encounter with Opswise Controller.

Database

Error in your SQL syntax

Maximum open cursors have been exceeded
Out-of-Range Value during Database Initialization
JDBC Connections Time Out

DB2 JDBC License Error

Installation

Processes Will Not Start Automatically (Debian Linux)
Windows install fails with 'Service marked for deletion’

Error when Starting Controller

Tomcat Post Limit: STATUS_MAX_POST_SIZE_EXCEEDED

Operations

Cannot launch a task

VBScript stuck in "Running" state

My Opswise Controller License has Expired
Packet for query is too large

Invalid login credentials for refreshing target agents
Invalid Call Error: Invalid call to setDataSource()
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Error in your SQL syntax

Problem

When you execute an SQL task that includes multiple SQL commands, the following error message (for example) may display:

I NSERT | NTO opswi se_deno (nanme, value) values ("A, 'F);
I NSERT | NTO opswi se_deno (nane, value) values ('B, 'S);
I NSERT | NTO opswi se_deno (name, value) values ('C, 'F);

Solution

Multiple queries, by default, are disabled for MySQL. To enable multiple queries, append the following string to the Connection URL field in the
Database Connections resource definition:

?al | omMul ti Queries=true

The following example is a URL connection string for a MySQL Database Connection resource definition:

jdbc: nysql ://1ocal host: 3306/ opswi se?al | owMul ti Queri es=true
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Maximum open cursors have been exceeded

Problem

During large imports on Oracle, you could receive following error message:

ORA-01000: naxi mum open cursors exceeded

(The cursors are used only during the import; they then are closed.)

Issue the following sql*plus utility command to check the current value for maximum open cursors:

show par anet er open_cursors

A listing similar to the following will display:

SQ.> show par aneter open_cursors;

NAVE TYPE VALUE
open_cursors i nteger 1000
Solution

An open_cur sor s value of 1000 should be sufficient for all large imports.

You can temporarily set the open_cur sor s value with the following SQL:

alter system set open_cursors=1000

To make a permanent change, you must set the open_cur sor s value in the initialization parameters file.
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Out-of-Range Value during Database Initialization

Problem

During the database initialization performed on initial start-up, you could receive the following message:

The conversion of a varchar data type to a datetine data type of the value is out of range.

The problem likely is that the database was created in SQL SERVER Management Studio with a user that has other than English as the default
language.

Solution

Verify the installed default language and set the language to U.S. English.

To check what default language a server has installed, use the following SQL command:

sp_configure 'default |anguage'

If the resulting value is not 0, the default language is not U.S. English. Run the following SQL command to find the installed default language
setting and date format used:

sel ect nane , alias, datefornmat
from sysl anguages

where langid =
(sel ect value from naster..sysconfigures
where comrent = 'default |anguage')

To set the default language to U.S. English, use the following SQL statements:

sp_configure 'default |anguage', O
reconfigure with override

For further details, refer to this Microsoft Support page.
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JDBC Connections Time Out

Problem

JDBC connections from Linux to MS SQL Server 2008 R2/Windows 2008 R2 time out after 40 seconds causing SQL/Stored Procedure Tasks that
take longer than 40 seconds to fail with the following exception:

2014- 09- 22-14: 51: 37: 034 -0400 ERROR
[ Ops. Gener al . 15. EP. Sql Handl er . ecd8ab62183f 4b9dbf 32d3ead4ad0al26. 74b824ad1lca84142a40d3ec1f 84d4d2b. 0]
SQLSer ver Excepti on - Connection reset
com mi crosoft.sql server.jdbc. SQLServer Exception: Connection reset
at com microsoft.sql server.jdbc. SQLSer ver Connecti on. t er m nat e( SQLSer ver Connect i on. j ava: 1667)
at com m crosoft.sql server.jdbc. SQ.Server Connecti on. term nat e( SQLSer ver Connecti on. j ava: 1654)
at com mi crosoft.sql server.jdbc. TDSChannel . read(| OBuffer.java: 1789)
at com microsoft.sql server.jdbc. TDSReader . readPacket (| OBuf f er. j ava: 4838)
at com m crosoft. sql server.jdbc. TDSComrand. st art Response(| OBuf f er. j ava: 6150)
at
com mi crosoft.sql server.jdbc. SQLSer ver Prepar edSt at ement . doExecut ePr epar edSt at enent ( SQLSer ver Pr epar edSt at €
at
com mi crosoft. sql server.jdbc. SQLSer ver Prepar edSt at ement $Pr epSt nt ExecCnd. doExecut e( SQLSer ver Pr epar edSt at er
at com m crosoft.sql server.jdbc. TDSComrand. execut e( | OBuf f er. j ava: 5696)
at
com mi crosoft.sql server.jdbc. SQLSer ver Connect i on. execut eConmand( SQ.Ser ver Connecti on. j ava: 1715)
at
com mi crosoft.sql server.jdbc. SQLSer ver St at enent . execut eComrand( SQLSer ver St at enent . j ava: 180)
at
com ni crosoft.sql server.jdbc. SQLServer St at enent . execut eSt at enment (SQ.Ser ver St at enent . j ava: 155)
at
com mi crosoft.sql server.jdbc. SQLSer ver Prepar edSt at enent . execut e( SQLSer ver Pr epar edSt at enent . j ava: 332)
at
com st onebranch. opswi se. server. events. Sql Event Handl er . st or edPr oc( Sgl Event Handl er . j ava: 266)

Resolution

To disable TCP Chimney Offload, follow these steps:

Step 1 Use administrative credentials to open a command prompt.
Step 2 At the command prompt, enter the following command: net sh int tcp set gl obal chi mey=di sabl ed

Step 3 Press ENTER:.

For additional information, see:

http://support.microsoft.com/kb/951037
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DB2 JDBC License Error

Problem

A SQL or Stored Procedure task using a DB2 Database Connection may fail with the following error message:

The 1BM Data Server for JDBC and SQLJ |icense was invalid or was not activated for the DB2 for z/OS
subsystem |f you are connecting

directly to the data server and using DB2 Connect Unlimted Edition for Systemz, performthe
activation step by running the activation

programin the |license activation kit. If you are using any other edition of DB2 Connect, obtain the
license file, db2jcc_license_cisuz.jar,

fromthe license activation kit, and follow the installation directions to include the license file in
the class path.

Solution

The db2j cc_| i cense_ci suz. | ar file needs to be included in the classpath for Universal Controller.

Step 1 Copy the db2j cc_l i cense_ci suz. j ar file to the following directory:

Windows
[tontat-install]\webapps\opswi se\VEB-INF\Iib

UNIX
[tontat-install]/webapps/ opswi se/ VEB-INF/1ib

Step 2 Restart Universal Controller.
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Processes Will Not Start Automatically (Debian Linux)

Problem
For Debian Linux environment: Outboard 5.1.0 processes will not start automatically at boot time.

Debian Linux does not provide the chkconfig command and therefore cannot work with the runlevels specified in the opsagent, opstransport,

opsmsghub scripts provided in/etc/init.d.

This is a known problem; we are working on a solution.

10 / ops-61x-t&t



Opswise Controller 6.1.x Troubleshooting and Tutorials

Windows install fails with 'Service marked for deletion'

Problem

In a Windows environment, for an upgrade installation of the Outboard 5.1.0 components, the install fails with the following message:

"This Service is narked for deletion'

Solution
Before running the install or upgrade process, make sure you first exit the Windows Services Console. If you do not, you likely will get this error.

If this occurs, exit the Windows Services application and re-run the install.
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Error when Starting Controller

Problem

Upon starting the Opswise Controller, the opswi se. | og shows ERR:

SQLSTATE: HY000, SQLERR 1040, ERRMSG [ uni xODBC] [ MySQL] [ ODBC 5.1 Driver]Too many connections

Solution

You must set additional connections in your database server:

M/SQ - /etc/ny.conf - nmax_connections=500 (default is either 100 or 150)
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Tomcat Post Limit

Problem

The following error message displays:

The server did not receive the data that was sent to it. Please see the docunentation for
i sc. RPCResponse. STATUS_MAX_PGOST_SI ZE_EXCEEDED

Resolution
Remove the post limit by specifying the following attribute on the <Connector> elementin conf/server. xm :

maxPost Si ze="- 1"
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Cannot launch a task

Problem

You cannot launch a task.

The problem may be with your credentials. Check the stderr for the following message:

ops_suexec: Not enough privileges. Check SUID bit and binary owner.

Solution

If the error message is present, issue the following commands as root in the $WVS_HOMWE/ bi n directory:

chown root ops_suexec
chrmod 4755 ops_suexec
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VBScript stuck in "Running" state

Problem

By default, Windows uses a GUI-based VBScript interpreter (wscri pt . exe). With this interpreter, if your script tries to display an error message
that requires a user-response (for example, Click OK), you will never see the dialog box. The script therefore gets stuck in the "Running” state.

Solution

To avoid this, we recommend you use the console version of the VBScript interpreter (cscri pt. exe). To do so, specify cscri pt. exe before
the script name in a task definition, as shown in the following example:

"cscript.exe C\Wrk\script.vbs".
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My Opswise Controller License has Expired

Problem

If your Opswise Controller license has expired, you will not be able to run any tasks. If you attempt to run a task under an expired license, the
Controller will place the task in the Defined state.

When you log in to the Controller, the Universal Automation Center Console will displays a license expiration informational message if your
license will expire within a week, and an error message if your license already has expired.

Additionally, if you have configured the Controller for System Notifications, system notifications are sent when the Controller license will expire in
seven days and if the license already has expired.

There are two other methods you can use to check on license expiration.

Method 1

Check the System Details widget (view the system-defined Home Dashboard or, on the Reporting navigation pane, click Widgets) to see how
many days are left on your license.

The Days: #/# entry in the License field indicates the current day of your current license and the total number of days in the license. If the
numbers are identical, your license has expired.

System Details e
License: [Agents: 15/5000] [Triggers: Unlimited] [Tasks: Unlimited] [Days: 1/365]
Mode Id: opswiseb:B8-opswiseb
MNode Mode: Active
MNode Uptime: 2 Hours 27 Minutes 13 Seconds
Mode Time: 2014-07-08 14:18:22 -0400
Release: 6.1.0.0
Build: build 208
Build Date: 07-07-2014_0909
Database Type: MYSQL
Database Mame: opswiseb
Database URL: jdbc:mysqgl://db2 stone. branch/
Database Connections:  In Use: 0, Total: 3
Memory Maximum: 989.88 MB
Memaory Used: 65.13 MB (6.558%)
Memory Free: 92474 MB (93.42%)
Method 2

Check the Controller log file.

If your license has expired, the following two messages should appear in the log at the midnight roll-over:

2015-01-07-00: 00: 00: 006 ~ WARN [ Ops. Ti mer . For ecast _Refresh. 0] License Viol ation: Nunber of Days has
exceeded # suspendi ng system
2015-01- 07- 00: 00: 00: 006 I NFO [ Ops. Ti ner . For ecast _Refresh. 0] Pausing the server.

Additionally, this message should appear in the log if you try to run a task under an expired license:
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2015-01-07-09: 32: 27: 728 I NFO [ Ops. Avai | abl e. 2367. 0] System paused, waiting for resune

Solution

Contact Stonebranch Customer Support.
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Packet for query is too large

Problem

During operations, the following message may appear in the Opswise Controller log:

Packet for query is too |arge (1084852 > 1048576).

Solution
Change this value on the database server by setting the MySQL max_allowed_packet configuration variable.

For detailed information about this variable, refer to the MySQL reference manual.
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Error when refreshing target agents

Problem
An error occurs when you click Refresh Target Agents on a Promotion Target record and you are using invalid login credentials for the target

Opswise Controller instance.

The user interface on source machine will show the following error:

GET http://NN. NNN. NN. N: 8080/ opswi se/ resources/ agents/list returned a response status of 401
Unaut hori zed

The the Controller log on the source machine will show the following error:

ERROR [ htt p- 8080-10] com sun.jersey. api.client. Uniform nterfaceException:
GET http:///opswi se/resources/agents/list returned a response status of 401 Unaut hori zed"

The target machine will return the following error:

ERROR [http--#] *** ERROR *** Login using Basic Authentication failed for:

Solution
Update the Promotion Target record with valid login credentials and try the promotion again.
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Invalid Call Error

Problem
The following error message displays:

onUncaught Exception: Exception caught: Invalid call to setDataSource() passing null.

Resolution

You may need to update the LimitRequestLine property in the Apache ht t pd. conf file to its default value, 8190.
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Error Messages

Error Messages

This page identifies error messages (in alphabetical order) that you may receive for Opswise Controller.

For each error, there is a link to the cause problem, and its solution, in Problem Resolution.

GET http://NN. NNN. NN. N: 8080/ opswi se/ resour ces/ agents/list returned a response status of 401
Unaut hori zed

(in user interface on source machine)

ERROR [ htt p-8080-10] com sun.jersey.api.client.Uniform nterfaceException:
CGET http:///opsw se/resources/agents/list returned a response status of 401 Unauthorized"

(in Opswise log on source machine)

ERROR [http--#] *** ERROR *** Login using Basic Authentication failed for:

(on Target machine)

See Error when refreshing target agents.

I NSERT | NTO opswi se_deno (nanme, value) values ("A, 'F);

See Error in your SQL syntax.

onUncaught Excepti on: Exception caught: Invalid call to setDataSource() passing null.

See Invalid Call Error.

ops_suexec___Not enough privileges. Check SU D bit and binary owner

See Cannot launch a task.

ORA- 01000: maxi mum open cursors exceeded

See Maximum open cursors have been exceeded.
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Packet for query is too |large (1084852 > 1048576

See Packet for query is too large.

SQLSTATE: HY000, SQLERR. 1040, ERRVMSG uni xODBC MySQL ODBC 5.1 Driver Too many connections

See Error when Starting Controller.

The conversion of a varchar data type to a datetine data type resulted in an out-of-range val ue.

See Out-of-Range Value during Database Initialization.

The 1 BM Data Server for JDBC and SQLJ |license was invalid or was not activated for the DB2 for z/OS
subsystem |f you are connecting directly to the data server and using DB2 Connect Unlimited Edition
for Systemz, performthe activation step by running the activation programin the |icense activation
kit. If you are using any other edition of DB2 Connect, obtain the license file,

db2j cc_license_cisuz.jar, fromthe license activation kit, and follow the installation directions to
include the license file in the class path.

See DB2 JDBC License Error.

The server did not receive the data that was sent to it. Please see the docunentation for
i sc. RPCResponse. STATUS_MAX_PGOST_SI ZE_EXCEEDED

See Tomcat Post Limit.

"This Service is marked for del etion'

See Windows install fails with 'Service marked for deletion'.

/
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Tutorials

Introduction

The tutorials guide you through features of Opswise Controller. They also provide links to more detailed information about each aspect of the
Controller.

Once you have completed the tutorials, you should have a basic understanding of how the features work together to automate your environment.

Before you begin, we recommend that you read the Setting up Opswise Controller and User Interface sections of this documentation to familiarize
yourself with user interface navigation and terminology.

', Note
During the course of performing these tutorials, you will build up a small database of demonstration records that you will re-use
in subsequent exercises. To avoid having to reenter data, do not delete the records.

The navigation pane on the left lists the tutorials in the sequence they should be read; many of them refer to information created in one or more
previous tutorials.

The following table lists the tutorials by topic, rather than sequence.

Tasks

Creating and Manually Launching a Simple Task

Running a Windows Task

Launching a Task Automatically Using a Simple Time Trigger
Launching a Task Every Monday Except Holidays

Launching a Task Every Two Hours During Workday
Launching Tasks at a Future Time

Launching an Email Task Based on a File Monitor

Launching an Email Task Based on a Task Monitor
Launching Tasks Using a Cron Trigger

Aborting a Process Launched by a Task

Force Finishing, Force Finish-Cancelling, and Cancelling a Task
Accessing Task Instance Details

Monitoring Task Activity

Workflows

Creating a Simple Workflow
Running a Workflow with a Conditional Path
Running a Workflow with Multiple Conditional Paths

Running a Workflow with Skipped Criteria
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Finding and Inserting Tasks in an Active Workflow

Skipping, Unskipping, and Showing-Hiding Skipped Task Instances

Variables

Using Variables in a Simple Task

Using Variables in a Workflow

Custom Days

Creating Custom Days and Periods

Forecasting

Generating Forecast Data

Virtual Resources

Setting Up a Virtual Resource

User Interface

Creating a Widget

Creating a Dashboard and Selecting Widgets

Business Services

Creating Business Services
Assigning Records to Business Services

Viewing Activity by Business Service

Reports

Creating a Report

Creating a Report Based on Business Services

Security

Creating Users and Assigning Permissions

Creating User Groups and Assigning Permissions
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Tutorial - Creating and Manually Launching a Task

In this tutorial, you will:
® Create a Timer task.

® Manually launch the task.
® View task instance Details of the task.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Task. The Timer Tasks list displays.
Step 2 Click New. The Timer Task Details displays.

® In the Task Name field, enter stonebranch-timertask-01.
® |n the Time in Seconds field, enter 60.

Timer Task Details =|=][*

[E] save $ Close

Timer Task

— General

Task Name : stonebranch-imerask-01 Version 1
Task Description :

Member of
Business Senvices

Hold on Start: [7]

Virtual Resource . Hold Resources on B
Priority : Failure :
— Timer Details

Timer Type : |Seconds v

Time in Seconds: 60

— Time Options

Late Start: [7]
Late Finish: [7]
Early Finish : [7]

User Estimated
Duration :

> » | HH:MM:SS

E) save # close

Step 3 Click Save.

Step 4 On the Timer Tasks list, right-click stonebranch-timertask-01 task to display an Action menu.

Step 5 Click Launch Task.

Step 6 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Step 7 Locate the stonebranch-timertask-01 task instance. When the task instance completes, the status changes from Running to
Success.
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Step 8 Click the Details icon next to the Instance Name of stonebranch-timertask-01 to display Details of the task instance.

Timer Task Instance Details: stonebranch-timertask-01

I [[=)[F
[ update 3 Re-run [ View Parent ¢ff Delete | & Refresh § Close
Timer Task Instance | Virtual Resources | Exclusive Reguests Notes.
[
— General
Instance Name : |stonebranch-timertask-01 Reference Id : 1
Task: stonebranch-timerask-01 E Invoked By : |Manually Launched
Task Description :
Member of
Business Execution User : |jops.admin
Services :
Virtual Resource - Hold Resources on o
Priority -

Failure :

— Status

Status : |Success

Status Description :

Start Time ;| 2014-07-24 14:52:11 -0400 End Time : |2014-07-24 14:53:11 -0400

Dwration : |1 Minute 0 Seconds

— Timer Details
Timer Type : |Seconds ~
Wait Time in 50
Seconds :
— Statistics
User Estimated Average Estimated N
End Time - End Time - 2014-07-24 14:52:11 -0400
Shortest Estimated Longest Estimated b
End Time : End Time :

[}

For additional information, see:

® Creating Tasks
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Tutorial - Running a Windows Task

® Creating a Simple Windows Task
® Manually Retrieving Output from a Windows Task
® Attaching Output to an Email Notification

To perform this tutorial, you need a running Opswise Universal Agent for Windows.

Creating a Simple Windows Task

Step 1 From the Automation Center navigation pane, select Tasks > Windows Tasks. The Windows Tasks list displays.
Step 2  In the empty Windows task Details below the list:
® In the Task Name field, enter stonebranch-windowstask-01.

® |n the Agent field, select your Windows agent.
® |n the Command field, enter md c:\tutorial.

Step 3 Click Save.
Step 4 On the Windows Tasks list, right-click stonebranch-windowstask-01 to display an Action menu.
Step 5 Click Launch Task.

Step 7 Check the Activity Monitor for the task instance.

Manually Retrieving Output from a Windows Task

In this Windows task, we will run a DIR command. Normally, you would use the Automatic Output Retrieval field to specify that any output
generated by the command be attached to the task instance after the task completes. However, if you did not specify that output be attached, you
can manually retrieve it after the task instance has run. In this exercise, we will manually retrieve and display the output.

Step 1 Use the same steps to create another Windows task called stonebranch-windowstask-02. Do not specify Automatic Output
Retrieval, and use the following command:

dir c:\w ndows

Step 2 Save and launch the task.

Step 3 Locate and open the task instance on the Activity Monitor.
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Step 4 Note that the Output tab is empty. Click Retrieve Output. The Retrieve Output window appears:

Retrieve Qutput | [

¥ Standard Qutput and Standard Error
Output Type : € Standard Qutput
" Standard Error

Start Line : 1
Mumber of Lines : 100
Scan Text :

Submit Cancel

Step 5 Change the number of lines to 300 and click Submit.

Step 6 Click the Output tab. The STDOUT (standard output) displays on the output list, as shown in the following example:

Windows Task Instance Details: stonebranch-windowstask-02 = [=][%:
Windows Task Instance | Virtual Resources | Exclusive Regquests Output Notes
Type Aftempt Output Updated By Updated

Volume in drive C has no label.
Volume Serial Number is 74F4-252¢

Directory of o:\windows

01/17/2012 08:04 <DIR>

01/17/2012 08:04 <DIR> -

07/13/2009 10:37 <DIR> AppCompat

0171772012 07:58 <DIR> ZppPatch

11/20/2010 05:1¢6 €5,024 bfsvc.exe

07/14/200% 12:52 <DIR> Boot =
07/14/2008 12:52 <DIR> Branding T
10/08/2008 02:11 <DIR> CsC

07/14/2009 12:52 <DIE> Cursors

12/23/2009 01:41 <DIE> debug

07/14/2009 12:52 <DIR> diagnostics

07/14/2009 12:56 <DIR> Digitallocker

07/14/2009 12:52 <DIR> Downloaded Program Files

1070372005 02:11 1,774 DtcInstall.log

01/17/2012 07:53 <DIR> ehome

10/09/2005 11:42 <DIR> en-US

11/20/2010 05:17
07/13/2008 05:14
07/14/2009 03:54
10/09/2009 01:54
07/13/2009 09:14
07/13/2009 09:14
01/17/2012 08:06

2,616,320 explorer.exe
13,824 fveupdate.exe
<DIR> Globalization
<DIR> Help
437,152 HelpPana.axs
15,360 hh_exe
21,337 iis7.log

0771472005 12:56& <DIR> IME

01/22/2014 0&:27 <DIR> inf

07/14/200% 12:52 <DIR> LZSchemas
07/13/2008 10:03 <DIR> LiveKernelReports
10/08/2008 02:30 <DIR> Logs

07/13/2009 06:58 42,131 mib.bin
01/17/2012 08:1% <DIE> Microsoft .NET
10/08/2009 01:00 <DIR> Minidump
07/13/2009 10:04 <DIR> ModemLogs

06/10/2009 05:13
07/13/2005 03:14
10/09/2005 01:00

1,405 msdfmap_ini
173,712 notepad._exe
124,958 ntbtlog-txt

FEREEEE PPN RE R EREE

10/03/2005 01:54 <DIR> nview

07/14/200% 12:52 <DIR> 0ffline Web Pages

10/08/2008 11:2¢€ <DIR> Panther

07/14/2009 12:52 <DIA> Performance

04/15/2013 01:2% 180,958 PFRO.log

07/13/2009 10:37 <DIR> PLR =

Attaching Output to an Email Notification
In this exercise, we will modify the stonebranch-windowstask-02 task with an Email notification that includes the output from the DIR command.

Step 1 Open the stonebranch-windowstask-02 task.
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Step 2 Click the Actions tab.

Step 3 Click Email Notification and then click the New button.

Step 4

In the Email Notification Details, specify the following:

Status=Success

Email Connection=Your email connection
To=Your email address

Subject=Output

Body=See attached.

Attach Standard Output=enabled

Start Line=1

Number of lines=300

Email Hotification Details

Email Notification

— Action Criteria

—|E)x
[F] Update ¢ Delete % Refresh 3 Close

E

Status | | SUCCESS
Exit Codes :
On Late Start: [7]
On Late Finish : [7]
On Early Finish : []

Description :

— Action Details

Email Template :

Reply-To :

e

Email Connection : | OPSWISE-EMAIL 7 E

stonebranch@stonebranch.com
To:

Cc:

Bceo:

Subject: Output

See attached

Body :

Attach Standard Output : Start Line 1

MNumber of Lines : 300

Step 5 Click Save.

Step 6 Launch the stonebranch-windowstask-02 task.

/

0ps-61x-t&t




Opswise Controller 6.1.x Troubleshooting and Tutorials

Step 7 Once the Windows task goes to success, check your inbox for the email. The output is attached, as shown in the following example.

Ol.,ﬂput Inbox % F

opswise-email@stonebranch.com & 3:19 PM (1 minute ago) -~ -
to me |-

See attached.

B STDOUT_Thu_Jul... '
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Tutorial - Launching a Task Automatically Using a Simple Time Trigger
In this exercise, we will define a time trigger that launches our Timer task every one minute.

Step 1  From the Automation Center navigation pane, select Triggers > Time Triggers.
Step 2 | Click New.

Step 3  In the Name field, enter stonebranch-timetrigger-01.

Step 4  In the Task(s) field, click the Add-Remove Multiple icon.

Step 5  In the Collection window, locate the Timer task created in the Creating and Manually Launching a Task tutorial,
stonebranch-timertask-01, move it to the Tasks List window, and click Save.

Edit Members BI=IE3
Collection Tasks List
Timer v 7 stonebranch-timetrigger-01

Task Hame Type |~ Task Name * -
stonebranch-timertask-02 Timer stonebranch-timertask-01
stonebranch-timertask-03 Timer
stonebranch-timertask-04 Timer
stonebranch-timertask-05 Timer

(=+]

[+]

[»]

[«]

[l save Cancel

Step 7 Inthe Time Style field, select Time Interval.

Step 8  Inthe Time Interval field, enter 1.
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Step 9  Inthe Time Interval Units field, select Minutes.

Time Trigger Details: stonebranch-timetrigger-01 =) (= {B
v [E] Update (& Enable (&) Trigger Now List Qualifying Times . [F) Copy ¢ Delete |4 Refresh 3 Close

Time Trigger Variables Versions

| =

— General
Hame : stonebranch-timetrigger-01 Version : 7
Description :

Member of
Business v
Senices:

Calendar : |System Default v E Time Zone ;| System (US/Eastern) v

stonebranch-timertask-01

Task(s):

AR

— Status
Forecast: [7] Status : | Disabled
Skip Count : 0

Skip Trigger if
Active : a

Simulate ;| — System Default — v

— Time Details
Time Style :  Time Interval .
Time Interval : 1 Enable Offset: []

Time Interval [ roe v
Units

— Day Details
Day Style - | Simple »
& Daily " Business Days (" Specific Day(s)

— Restrictions
Restrict Times : [7]

Special
Restriction : a

] Update &} Enable (&) Trigger Now List Qualifying Times [y copy & Delete 4| Refresh ## Cclose

Step 10 Click Save.
Step 11 By default, triggers are disabled. To enable this trigger:

1. On the Time Triggers list, right-click stonebranch-timetrigger-01 to display an Action menu.
2. Click Enable to enable the trigger. Note that the Enabled column on the trigger list now displays a green check-mark for this
trigger.

Step 12 From the Automation Center navigation pane, select Activity to display the Activity Monitor. Note that a new instance of
stonebranch-timertask-01 appears every one minute.
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Step 13 Click the most recent instance of stonebranch-timertask-01 to view its details, and note that the Invoked By field contains the
name of the trigger that launched this task.

=[O X

Timer Task Instance Details: stonebranch-timertask-01
[F] Update 3 Re-run i Delete |4 Refresh 3 Close

Timer Task Instance | Virtual Resources || Exclusive Reguests Notes
— General E
Instance Mame : | stonebranch-timertask-01 Reference Id 3
Task: stonebranch-timertask-01 E Invoked By . | Trigger: stonebranch-timetrigger-01

Task Description :

Member of
Business Execution User : | ops.admin
Senices :
Virtual Resource " Hold Resources on a
Priority : Failure

— Status
Status : |Success

Status Description :

Start Time : | 2014-07-24 16:37:54 -0400 End Time : | 2014-07-24 16:38:54 -0400

Duration : |1 Minute 0 Seconds

— Timer Details

Timer Type : | Seconds

Time in Seconds : 60
— Statistics
User Estimated Average Estimated = p—
i Erd Tl | 2014-07-24 16:33:55 0400
Shortest Estimaled (5044 07 54 16:38:55 -0400 Longest Estimaled (5014 07 24 16:38:55 0400 b
End Time : EndTime

For additional information, see:
® Triggers

® Time Trigger
® Enabling and Disabling Triggers
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Tutorial - Launching a Task Every Monday Except Holidays

® [ntroduction

® Create Calendar and Custom Days
® Create a Time Trigger

® Adding a Complex Restriction

Introduction

In this exercise, we will define a trigger that runs the stonebranch-timertask-01 task (created in the Creating and Manually Launching a Simple
Task tutorial) automatically every Monday at 1 p.m., except holidays.

For cases where Monday falls on a holiday, we will define a special restriction in the trigger that instructs the Controller to run the task on the next
business day.

We will define the business days and holidays in a calendar.

Create Calendar and Custom Days

Before building the trigger, we will create the calendar:

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7
Step 8
Step 9

Step 9

From the Automation Center navigation pane, Others > Calendars to display the Calendars list.
Click New to display an empty Calendar Details.

Enter stonebranch-calendar-01 in the Name field.

In the Description field, enter Defines our company business days and holidays.

Do not change the default selections for Business Days (Monday through Friday). Click Save.

Calendar Details

Calendar

=[O %

[E] save ¥ Close

Details

Name : stonebranch-calendar-01 Version : 1

Description : Defines our company business days and holidays

Member of
Business
Services :

Elus[i)n;sss. Sunday [] Monday Tuesday Wednesday Thursday Friday Saturday [

E] save # close

Open stonebranch-calendar-01 and click the Custom Days tab.

On the Custom Days list, click the New button. A Custom Day Details for a new Custom Day displays.

In the Name field, enter stonebranch-customday-01.
In the Description field, enter Labor Day.

Enable the Holiday field.
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Step 10 In the Type field, select Relative Repeating Date. In the three additional fields that appear, make the following selections:
® When = 1st
® Day of Week = Mon
® Month = Sep

Custom Day Details: stonebranch-customday-01 =] {28

Step 11
Step 12
Step 13
Step 14

Step 15

Custom Day

Calendars

Versions

5] Update

[£] ListQualifying Dates 5 Delete

% Refresh 3 close

— Details
Name :

Description :
Holiday :

Type:

When :

Day Of Week :

Wonth :

stonebranch-customday-01
Labor Day

Relative Repeating Date
st

Maon

Sep

Version :

[E] Update

[] List Qualifying Dates |

i) Delete

4| Refresh

## Close

Click Save to add this Custom Day to the Calendar.

On the Custom Days list, click the New button. A Custom Day Details for a new Custom Day displays.

In the Name field, enter stonebranch-customday-02.

In the Description field, enter The founder's birthday.

Enable the Holiday field.

Step 16 In the Type field, select Relative Repeating Date. In the three additional fields that appear, make the following selections:
®* When = 2nd
® Day of Week = Mon
® Month = Oct

Custom Day Details: stonebranch-customday-02 | (=1 (B

[E] Update [£] ListQualifying Dates ¢fi] Delete |4 Refresh € Close

35

Custom Day Calendars Versions
— Details
Name : stonebranch-customday-02 Version : 4
Description : Columbus Day
Holiday :
Type : |Relative Repeating Date ¥
When : |2nd ~
Day Of Week: |Mon v
Monih : |Oct v
[F] Update | [£] ListQualifying Dates i Delete % Refresh # Close

Step 17 Click Save to add this Custom Day to the Calendar.

Create a Time Trigger

Step 1
Step 2
Step 3

Step 4

From the Automation Center navigation pane, select Triggers > Time Trigger to display the Time Triggers list.

Click New to display an empty Time Trigger Details.

In the Name field, enter stonebranch-timetrigger-01.

In the Description field, enter Run every Monday at 1 p.m., roll to Tuesday if Monday is a holiday.
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Step 5  Inthe Calendar field, select stonebranch-calendar-01.
Step 6  In the Task(s) field, select stonebranch-timertask-01.
Step 7  In the Time Style field, keep the default, Time.
Step 8  Inthe Time field, enter 13:00 (1 p.m. in 24-hour time).
Step 9  Inthe Day Style field, keep the default, Simple.
Step 10 Enable Specific Day(s) field and select Monday.
Step 11 Enable Special Restriction and select:

® On Holiday in the Situation field.

® Next Business Day in the Action field.

Step 12 Click Save.

Time Trigger Details: stonebranch-timetrigger-1 M |[=]{E
v [ Update €} Enable (& Trigger Now [7] List Qualifying Times... [ Copy ¢i# Delete |% Refresh 3£ Close
Time Trigger Variables Versions
— General
Name: stonebranch-timetrigger-01 Version T

Description : Run every Monday at 1 p.m., roll to Tuesday if Menday is a holiday.

Member of -
Business Senvices

Calendar : |stonebranch-calendar-01 v D Time Zone : | System (US/Eastern) %3

stonebranch-timertask-01

Task(s): ’5
— Status
Forecast: [] Status : Disabled
Skip Count: 0
Skip Trigger if
Active : o
Simulate : |- System Default— w
— Time Details
Time Style : | Time v

Time: (13 |w | |00 | |HH:MM

— Day Details
Day Style : | Simple v
¢ Daily ¢~ Business Days * Specific Day(s)

Sunday [7] Monday Tuesday [] Wednesday [7] Thursday [7] Friday [7] Saturday []

— Restrictions
Special Restriction : Action : |Next Business Day v
Simple Restriction : Regtﬁgizlﬁx |}
Situation : |On Holiday w
[l update &} Enable (%3 Trigger Now | | =] List Qualifying Times... Iy copy ) Delete 4| Refresh 3 Close

Step 13 Click the List Qualifying Times button to display the *List Qualifying Times Input pop-up dialog.
Step 14 In the Number of Dates/Times field, enter 15.

Step 15 In the Start Date fields, Select July 25 2014.
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Step 16 Click Submit to display a list of Qualifying Times when the trigger will launch the task.

Qualifying Times =1

stonebranch-timetrigger-01

Run every Monday at 1 p.m., roll to Tuesday if Monday is a
holiday.

E Listing From: Friday, July 25, 2014 10:42.45 EDT -0400 [%]

UserTrigger Timezone: US/Eastern

Monday, July 28, 2014 13:00:00 EDT -0400
Maonday, August 04, 2014 13:00:00 EDT -0400
Maonday, August 11, 2014 13:00:00 EDT -0400
Monday, August 18, 2014 13:00:00 EDT -0400
Monday, August 25 2014 13:00:00 ECT -0400
Tuesday, September 02, 2014 13:00:00 EDT -0400
Maonday, September 08, 2014 13:00:00 EDT -0400
Maonday, September 15, 2014 13:00:00 EDT -0400
Monday, September 22, 2014 13:00:00 ECT -0400
Maonday, September 29, 2014 13:00:00 EDT -0400
Maonday, October 06, 2014 13:00:00 EDT -0400
Tuesday, October 14, 2014 13:00:00 EDT -0400
Monday, October 20, 2014 13:00:00 EDT -0400
Monday, October 27, 2014 13:00:00 EDT -0400
Maonday, Movember 03, 2014 13:00:00 EST -0500

As shown in the list, the task will not run on the two Mondays that you have defined as holidays in the calendar, but instead will run
the the following Tuesday.

Adding a Complex Restriction

The following steps show you how to add a complex restriction to the stonebranch-timetrigger-01 trigger. In this case, you will add a restriction
that skips the last Monday of the year and instead triggers the task on the following Tuesday, just as it does for Mondays that are holidays.

Step 1 Enable Complex Restriction.

Step 2 In the Restriction Mode field, select Or.

Step 3 In the Restriction Adjective field, select Last.
Step 4 In the Restriction Noun field, select Monday.
Step 5 Inthe Restriction Qualifier field, select Year.

Step 6 Click Update.
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Step 7 Re-open the trigger, click the List Qualifying Times button, enter 25 in the Number of Dates/Times field, and click Submit. The
Qualifying Times list now shows an additional Monday (the last Monday of the year) on which the task will not be run.

Qualifying Times B [=]E

stonebranch-timetrigger-01

Run every Monday at 1 p.m., roll to Tuesday if Monday is a
holiday.

E Listing From: Friday, Juhy 25 2014 11:01:54 EDT -0400 @

UzerTrigger Timezone: US/Eastern

Manday, July 28, 2014 13:00:00 EDT -0400
Manday, August 04, 2014 13:00:00 EDT -0400
Manday, August 11, 2014 13:00:00 ECT -0400
Monday, August 18, 2014 13:00:00 EDT -0400
Monday, August 25 2014 13:00:00 EDT -0400
Tuesday, September 02, 2014 13:00:00 EDT -0400
Manday, September 08, 2014 13:00:00 ECT -0400
Monday, September 15, 2014 13:00:00 EDT -0400
Monday, September 22, 2014 13:00:00 EDT -0400
Manday, September 29, 2014 13:00:00 ECT -0400
Manday, October 06, 2014 13:00:00 EDT -0400
Tuesday, October 14, 2014 13:00:00 EDT -0400
Manday, October 20, 2014 13:00:00 EDT -0400
Maonday, October 27, 2014 13:00:00 EDT -0400
Manday, Movember 03, 2014 13:00:00 EST -0500
Monday, Movember 10, 2014 13:00:00 EST -0500
Monday, Movember 17, 2014 13:00:00 EST -0500
Manday, Movember 24, 2014 13:00:00 EST -0500
Manday, December 01, 2014 13:00:00 EST -0500
Monday, December 08, 2014 13:00:00 EST -0500
Monday, December 15, 2014 13:00:00 EST -0500
Manday, December 22, 2014 13:00:00 EST -0500
Tuesday, December 30, 2014 13:00:00 EST -0500
Monday, January 05, 2015 13:00:00 EST -0500
Monday, January 12, 2015 13:00:00 EST -0500

e
For additional information, see:

® Triggers

® Time Trigger

® Calendars

® Displaying Trigger Forecast Information
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Tutorial - Launching a Task Every Two Hours During Workday

In this exercise, we will define a recurring task that runs every two hours, limited to business hours — Monday through Friday from 9 a.m. to 5 p.m.
We will also instruct Opswise Controller not to run the task on holidays.

Also, if the task is still running two hours later when it is time to run the next task instance, the Controller will be instructed not to run the next
instance.

Step 1 = From the Automation Center navigation pane, select Triggers > Time Triggers. The Triggers list displays.
Step 2 Click the New button to display an empty Time Trigger Details.
Step 3  In the Name field, enter stonebranch-timetrigger-02.
Step 4  Inthe Description field, enter Run Every Two Hours During Business Hours Except Holidays.
Step 5  Inthe Calendar field, select stonebranch-calendar-01 (created in the Launching a Task Every Monday Except Holidays tutorial).
Step 6  In the Task(s) field, select stonebranch-timertask-01 (created in the Creating and Manually Launching a Simple Task tutorial).
Step 7  Enable the Skip Trigger if Active field. This tells the Controller not to trigger the task if the previous instance of the task is still active.
Step 8  Inthe Time Style field, select Time Interval and specify the following:
® Time Interval = 2
® Time Interval Units = Hours
Step 9  Enable the Restrict Times field and specify the following:
®* Enabled Start = 09:00
® Enabled End = 17:00
Step 10 Specify that this trigger should run on weekdays only by selecting either:

Day Style = Simple
Business Days = Enabled

OR

Day Style = Complex

Date Adjective = Every
Date Noun = Business Day
Date Qualifier = Year

Both methods use the Business Days specified in stonebranch-calendar-01.
Step 11 Enable the Special Restriction field and specify the following:

® Situation = On Holiday
® Action = Do Not Trigger
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/

Step 12 Click the Save button.

Time Trigger Details: stonebranch-timetrigger-02

Time Trigger Variables Versions

— General

v [E]] Update &) Enable (&} Trigger Now List Qualifying Times...

Cr) copy i Delete

= OX

4 Refresh 3% Close

E|

Hame : stonebranch-timetrigger-02

Member of
Business
Senvices

Calendar : |stonebranch-calendar-01

stonebranch-timertask-01

Task(s):

Description : Run Every Two Hours During Business Hours except Holidays

Bl

Version : 3

Time Zone ;| System (US/Eastern)

— Status

Forecast: [7]
Skip Count a

Skip Trigger if
Active el

Simulate | |- System Default —

Status : |Disabled

— Time Details

Time Style : | Time Interval v

Time Interval : 2

Enable Offset: [7]

Time Interval [, .
Units
— Day Details
Day Style ;| Simple v
" Daily  Business Days (" Specific Day(s)
— Restrictions

Restrict Times
Enabled Start: |09 |w | (00 | [HH:MW

EnabledEnd: (17 |v [[00 | |HHMK

Special
Restriction

Simple Restriction

Situation : |On Haliday

Action : |Do Not Trigger

Complex
Restriction : O

5] Update L Enable (& Trigger Mow List Qualifying Times...

[y copy 6 Delete

% Refresh

B Close

[
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Step 13 Re-open stonebranch-timetrigger-02 and click the List Qualifying Times button. The Qualifying Times list displays the next
scheduled 30 (by default) times when stonebranch-timetrigger-02 will launch stonebranch-timertask-01.

Qualifying Times = =]

stonebranch-timetrigger-02

Run Every Two Hours During Business Hours except
Holidays

E Listing From: Friday, July 25, 2014 13:47:58 EDT -0400 [%]

User/Trigger Timezone: US/Eastern

Friday, July 25, 2014 15:00:00 EDT -0400
Friday, July 25, 2014 17:00:00 EDT -0400
Saturday, July 26, 2014 09:00:00 EDT -0400
Saturday, July 26, 2014 11:00:00 EDT -0400
Saturday, July 26, 2014 13:00:00 EDT -0400
Saturday, July 26, 2014 15:00:00 EDT -0400
Saturday, July 26, 2014 17:00:00 EDT -0400
Sunday, July 27, 2014 09:00:00 EDT -0400
Sunday, July 27, 2014 11:00:00 EDT -0400
Sunday, July 27, 2014 13:00:00 EDT -0400
Sunday, July 27, 2014 15:00:00 EDT -0400
Sunday, July 27, 2014 17:00:00 EDT -0400
Maonday, July 28, 2014 09:00:00 EDT -0400
Maonday, July 28, 2014 11:00:00 EDT -0400
Maonday, July 28, 2014 13:00:00 EDT -0400
Monday, July 28, 2014 15:00:00 EDT -0400
Maonday, July 28, 2014 17:00:00 EDT -0400
Tuesday, July 29, 2014 09:00:00 EDT -0400
Tuesday, July 29, 2014 11:00:00 EDT -0400
Tuesday, July 29, 2014 13:00:00 EDT -0400
Tuesday, July 29, 2014 15:00:00 EDT -0400
Tuesday, July 29, 2014 17:00:00 EDT -0400
Wednesday, July 30, 2014 09:00:00 EDT -0400
Wednesday, July 20, 2014 11:00:00 EDT -0400
Wednesday, July 30, 2014 13:00:00 EDT -0400
Wednesday, July 30, 2014 15:00:00 EDT -0400
Wednesday, July 30, 2014 17:00:00 EDT -0400
Thursday, July 31, 2014 09:00:00 EDT -0400
Thursday, July 31, 2014 11:00:00 EDT -0400
Thursday, July 31, 2014 13:00:00 EDT -0400
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For additional information, see:
® Triggers

® Time Trigger
® Calendars
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Tutorial - Launching Tasks at a Future Time

In this exercise, we will create a trigger that will launch multiple tasks at the same time in the future (in two minutes). For this exercise, we will use
the SQL tasks created in the Running a Workflow with a Conditional Path tutorial.

(A future date also can be selected, but to see now that the tasks have been launched, keep the current date.)

Create a Temporary Trigger

Step 1 From the Automation Center navigation pane, select Triggers > Temporary Triggers. The Temporary Triggers list displays.
Step 2 Click the New button to display Temporary Trigger Details for a new trigger and enter/select the following values:

Name = Launch Tasks

Tasks = Timerl, Timer2, and Timer3 Timer tasks
Date = current date

Time =5 minutes from the current time

Time Zone = your time zone

Step 3 Click the Save button.

Temporary Trigger Details - (B %
v [l save 3 close

Temporary Trigger

— General

Name : Launch Tasks

Description :

Member of -
Business Senvices :

Calendar: |System Default v D Time Zone : System (US/Eastern) v

Timer1

Timer2
Taskis): Timer3

Bl

— Status
Forecast: []
Skip Count: 0

Skip Trigger if
acive:

Simulate : |— System Default — v

— Tempaorary Details
Date: 2014 | |Aug | |1 CAIES

Time: [16 |w [ |35 |w |HHMM

[ save 3 close

Step 4 Right-click Launch Tasks on the Temporary Triggers list and click Enable.

Step 5 Open the Activity Monitor to see that Timerl, Timer2, and Timer 3 are run at the selected time.

For additional information, see:

® Temporary Trigger
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Tutorial - Launching an Email Task Based on a File Monitor

Introduction

Create File Monitor Task
Create an Email Task

Create File Monitor Trigger
Test Your File Monitor Set-up

Introduction

In this exercise, we will monitor a machine for a specific file. When the file appears, we will send an email that uses variables to supply information
about when and how the email was sent.

In order to set this up, we need the following:

® Opswise Universal Agent

® File Monitor task

® File Monitor trigger

® Email task being launched by the trigger.

File Monitor trigger

THQQE.!E

Universal Agent
Manitors File Maonitor task Task launches when
File being maonitored for Trigger is satisfied

Prerequisites:
® |n order to perform this exercise, you need a Windows, Linux/Unix, or zZ/OS Agent running on the machine that is being monitored for the

file. Create a directory on the machine called opswi se tutori al . Later on, you will copy a text file to this directory to satisfy the File
Monitor trigger.

*,  Note
If you do not have a running Agent, you can bypass this step by manually satisfying the trigger, as per instructions in
the tutorial. However, you do need an Agent defined in the database.

® Since we are going to generate an email when the trigger is satisfied, you will need an Email Connection defined.

Create File Monitor Task

The File Monitor task monitors the agent machine for the specified file.

Step 1 = From the Automation Center navigation pane, select Tasks > File Monitors. The File Monitors list displays.
Step 2 Click the New button to display an empty File Monitor Details.

Step 3  In the Task Name field, enter stonebranch-filemonitor-01.

Step 4  Inthe Task Description field, enter Demo File Monitor.

Step 5  Inthe Agent field, select an Agent.
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Step 6  In the Monitor Type field, keep the default value, Create. (See File Monitor Task Details Field Descriptions for details about the
other file monitor options.)

Step 7  In the Monitor File field, type filel.txt. Since we have not specified any directory, the Controller will search the root directory.

Step 8  Enable the Recursive field. Since we are going to write our file to the opswi se tut ori al directory, we want the Controller to
search all sub-directories for the file.

Step 9  Inthe Stable (seconds) field, enter 5. This tells the Controller to satisfy the trigger only when the file has not changed in 5 seconds.

File Monitor Details: stonebranch-filemonitor-01 =|[=][%

[E] save $# close

File Monitor Variables Actions Virtual Resources | Mutually Exclusive Instances File Monitor Triggers Notes. Versions
— General
Task Hame : stonebranch-filemonitor-01 Wersion : 4

Task Description : Demo File Monitor

Member of
Business Services :

Hold on Start: []

Virtual Resource Hold Resources on B
Priority : Failure :

— File Monitor Details

Agent: |ga-agentsim1 - simagent! » D Agent Cluster » D
Agent Cluster
Agent Variable : [7] \ariable - E
Credsntials : ~ [7] cluster Broadcast: M
Credentials
Variable : o
. Trigger on
Monitor Type : | Create s Existence:
Monitor File(s) : file1
Recursive : [7] WMaximum Files :
File Owner:
Stable (seconds): 5
Scan Text:
— Time Options
Late Start: []
Late Finish: [0
Early Finish: []
User Estimated = = v | Hram:ss
Duration :

E) save ## Close

Step 10 Click Save.

Create an Email Task
Create the task that will run when the File Monitor is satisfied. In this case, we will generate an email, using the Email task:

Step 1 From the Automation Center navigation pane, select Tasks > Email Tasks. The Email Tasks list displays.
Step 2 Click the New button to display an empty Email task Details.

Step 3 Inthe Task Name field, enter stonebranch-emailtask-01.

Step 4 In the Description field, enter Send Email When File Appears.

Step 5 Inthe Email Connection field, select your Email Connection.

Step 6 Inthe To field, enter in your email address. This is where the email will be sent.

Step 7 In the Subject field, enter filel.txt arrived.
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Step 8 ' In the body field, enter the following Opswise Controller variable and Opswise Controller function:

Triggered by: ${ops_trigger_nane}
Date: ${_date}

Step 9 When the email is generated, the variables will be substituted with the name of the trigger that launched the Email task, along with the
date and time the task was launched.

Email Task Details: stonebranch-emailtask-01 =11k

[F] save 3 close

Email Task Variables Actions Virtual Resources | Mutually Exclusive Instances Triggers Notes Versions
— General
Task Name : stonebranch-emailtask-01 Version : 1

Task Description . Send Email When File Appears

Member of
Business Semvices

Hold on Start: [7]

Virtual Resource Hold Resources on B
Priority Failure :

— Email Details

Email Template «[] Email Connection : | QA-OPSWISE-MAILER ME

Reply-To

stonebranch@email.com
To

Cc

Bco

Subject: file1.tet arrived

Triggered by: ${ops_trigger_name}
Date: §{_date}

Body

— Time Options

Late Start: [7]
Late Finish: 7]
Early Finish: []

User Estimated
Duration

£
<

» [HH:MK:SS

[E] save 3 close

Step 9 Click the Save button.

Create File Monitor Trigger

Create the File Monitor trigger:

Step 1 From the Automation Center* navigation pane, select Triggers > File Triggers. The File Monitor Triggers list displays.
Step 2 Click the New button to display an empty File Monitor Trigger Details.

Step 3 In the Trigger Name field, enter stonebranch-filemonitortrigger-01.

Step 4 In the Description field, enter When File Arrives Send Email.

Step 5 In the Task(s) field, select stonebranch-emailtask-01.)

Step 6 Inthe File Monitor field, select stonebranch-filemonitor-01.
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Step 7 Click the Save button.

File Monitor Trigger Details: stonebranch-filemonitortrigger-01 == [ B4
v [l save 3 close
File Monitor Trigger Variables Versions
— General
Hame : stonebranch-filemonitortrigger-01 Wersion : 1

Description : When File Arrives Send Email

Member of -
Business Services :

Calendar : |System Default v D Time Zone : System (US/Eastern) v

stonebranch-windowstask-01

Task(s):

bIE

— Status
Skip Count 0 Status : Disabled

Skip Trigger if
Active o

r— File Monitor Details

File Monitor : |stonebranch-filemonitor-01 > D

— Restrictions
Restrict Times : []
Special Restriction : [

] save 3 Close

48

Test Your File Monitor Set-up

Test your File Monitor set-up.
Step 1 Enable the File Monitor trigger. This launches the File Monitor task. It will appear in the Activity Monitor with a status of Running.

Step 2 Do one of the following:

® If you have a running agent, place a text file called fi | el. t xt inthe opswi se tutorial directory on the machine that is
being monitored by the File Monitor task. When the file appears, the File Monitor task waits five seconds, as specified, and

then satisfies the trigger.
® If you do not have a running agent but do have an agent connected to your instance, you can manually satisfy the trigger as

follows:
1. From the Automation Center navigation pane, select Triggers > File Triggers to display the File Monitor Triggers

list.
2. Right-click the stonebranch-file monitortrigger-01 trigger and select Trigger Now.

Step 3 When the trigger is satisfied, the Email is sent. Go to the Activity Monitor and note that the astonebranch-emailtask-01 Email task
has been launched.

Step 4 Go to your email account where the email was sent and open the email. Note that the variables were resolved.

For additional information, see:

® Email Task

® File Monitor Task
® File Trigger

® Variables
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Tutorial - Launching an Email Task Based on a Task Monitor

Introduction

Select the Activity Monitor Problem Filter

Create an Email Template

Creating an Email Task Using the Email Template
Creating a Task Monitor Task

Creating a Task Monitor Trigger

Running the Task Monitor

Introduction

In this exercise, we will set up a Task Monitor and Task Monitor trigger. The Task Monitor will monitor all tasks for a status that indicates some
sort of problem. When the trigger is satisfied, Opswise Controller will launch an Email task that notifies a user that there is a problem. We will also
create an Email template for use in our Email task and create an Activity Monitor filter that displays only problem tasks.

The following illustration shows the various components used to trigger tasks based on the status of other tasks.

Task Monitor Task Monitor

Tasks bein i . .
monitored: E“ task: Looks for ;:s?l?:'lro::{g:ctzzz Tasl-'.s being
Windows tasks Failure status in when conditions ! trlgga‘rf.-d when
whose name Windows tasks ) it of conditions are

met, triggers list satisfied

begins with SF beginning with SF tasks.

Select the Activity Monitor Problem Filter

The first task we will do is select the Problem filter for the Activity Monitor. When the user receives an email indicating there is a problem, the user
can view this Activity Monitor to find out more information.

Step 1 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Step 2 Click the Click to start the Activity monitor button. All active task instances display.
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Step 3 From the Quick Filter drop-down list, select Status > Problem.

Dashboards Activity

|Last4shours » | [4 No quickfilter » | Custom Filter — None — v | 55 Filter
Instance Name: % Status » Active Type Status 7
Blocked
&5 Type » Completed

F‘%ﬂlem
Status is one of Running/Problems,
Defined Cancel Pending, In Doubt, Start Failure,
= . Confirmation Reguired, Cancelled,
e Waiting Failed

Held

Started/Finished Late

Exclusive Requested
Exclusive Wait
Resource Requested
Resource Wait
. Execution Wait

| B) Undeliverable

- Queued

Submitted

Action Required

Started

Running

Clickto start the Activity monitor

Running/Problems
Cancel Pending

In Doubt

Start Failure
Confirmation Required
Cancelled

Failed

Skipped

Finished

1 m >
Success

{5y Settings » | () (3 | H q b W Page of

The Activity Monitor now will display only Problem task instances.

Create an Email Template

Email Templates allow you to create pre-defined Email task information that you refer to when creating an Email task. This is useful if you have a
large number of common parameters on Email tasks but still require separate tasks.

Step 1 From the Agents & Connections navigation pane, select System > Email Templates. The Email Templates list displays.
Step 2  Click the New button to display an empty Email Template Details and enter the following values:

Template Name = Notification based on status

Email Connection = (a valid email connection)

To = (a valid email account)

Subject = Task Failure Alert

Body = Task failure, see Activity Monitor for Problems
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Step 3 Click the Save button.

Email Template Details | [=] {4
5] save ¥ close

Email Template

— Details
Template Name : Notification based on status

Email Connection : | QA-OPSWISE-MAILER - D
Reply-To :

dan.moran@stonebranch.com
To:

Cc:

Bee:

Subject: TaskFailure Alert

Task failure: see Activity Monitor for Problems.

Body :

[El save 3 close

Creating an Email Task Using the Email Template

Step 1 From the Automation Center navigation pane, select Tasks > Email Tasks. The Email Tasks list displays.
Step 2 Click the New button to display an empty Email Task Details and enter the following values:

® Task Name = Triggered by Task Status*
® Email Template = Notification based on status

Leave the remaining fields blank, since we want to use the information from the template. (If you fill in any of the duplicate
fields, the information from the task overrides the information from the template.)
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Step 3 Click the Save button.

Email Task Details =3x

[E] save ¥ Close

Email Tagk

-
— General

Task Hame : Triggered by Task Status
Task Description :

Member of

Business

Senvices :
Hold on Start: [7]

Virtual Resource 10 Hold Resources on B
Priority : Failure :

— Email Details

Email Template : |Nofification based on status v D Email Connection : v D

Reply-To :

To:

Bce:

Subject:

Body

— Time Options

Late Start: [7]
Late Finish : [0]
Early Finish: [7]

User Estimated
Duration :

» w » [HH:MM:55

El save 3 Close

Creating a Task Monitor Task

For this Task Monitor, we will monitor the status of all other tasks. If any task has a status that indicates there is some sort of problem, we will
generate an email. Once the Task Monitor is launched by the Task Monitor trigger, it remains active, launching an Email every time any of its
conditions are met. The Task Monitor task remains active until the Task Monitor trigger is disabled or until a user manually stops it.

Step 1 From the Automation Center navigation pane, select Tasks > Task Monitors. The Task Monitors list displays.
Step 2 = Click the New button to display an empty Task Monitor Details and enter the following values:

® Task Name = Monitors for Problems

® Status To Monitor = enable Running/Problems, Cancel Pending, In Doubt, Start Failure, Confirmation Required, Cancelled,
and Failed. (For a description of each status, see Displaying Task Instance Status).

® Monitoring Type = General Task(s)

® Task Type To Monitor = enable all task types (default)
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Step 3 Click the Save button.

Task Monitor Details =8x
[El] save 3 Close

Task Monitor

— General

Task Name : Monitors for Problems
Task Description

Member of
Business Semvices :
Hold on Start: [7]

Virtual Resource Hold Resources on [
Priority : Failure :

=
=
<

— Maonitor Details

Status To Monitor : |Running/Problems,In Doubt,Start Failure, Confirmation Required,Cancelled,Failed w
Monitoring Type : |General Task(s) v
Task Name
Condiion : =o€~ hd
Tasmmﬁ;” Worklow, Timer,Windows Linu/Unix Z/0S, File Monitar Manual Email File Transfer, 5L FTP File Monitor, Task Monitor,Stored Procedure,Indesca Sy... | v
Workflow Name
Condition - =Mo" ~ b
Time Scope : |— MNone — "
— Time Options
Late Start: [T
Late Finish: [7]
Early Finish : [7]
User Estimated - " v | HH s
Duration e

[ save 3 close

Creating a Task Monitor Trigger

As the last step in our set-up process, we will create the Task Monitor trigger, which controls when the Task Monitor task is started and stopped.

Step 1  From the Automation Center navigation pane, select Triggers > Task Monitor Triggers. The Task Monitor Triggers list displays.
Step 2 = Click the New button to display an empty Task Monitor Trigger Details and enter the following values:
® Name = Controls Monitors for Problems

® Task(s) = Triggered by Task Status
® Task Monitor = Monitors for Problems
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Step 3 Click the Save button.

Task Monitor Trigger Details: Controls Monitors for Problems - (3]
v [E]l update &) Enable () Trigger Mow LI Copy i Delete |4 Refresh 3 Close
Task Moniter Trigger Variables Versions
— General
Name : Controls Monitors for Problems ersion : 2
Drescription :
Member of v
Business Services :
Calendar : | System Default v D Time Zone : System (US/Eastern) >

Triggered by Task Status

Task(s): —

— Status
Skip Count: 0 Status : Disabled

Skip Trigger if
Active : 0

— Task Monitor Details
Task Monitor : | Monitors for Problems «[F

— Restrictions
Restrict Times : [0
Special Restriction : [7]

[E] update &} Enable 2 Trigger Now Cr Copy i Delete % Refresh 3 Close

Step 4 On the Task Monitor Triggers list, right-click Controls Monitors for Problems and then click Enable.

Running the Task Monitor

To test our set-up, we need to run a task to one of the failure statuses that will trigger the email. To do so, we will launch the Pause for Manual
Manual task created in the Running a Workflow with a Conditional Path tutorial and force it into Failed status.

Step 1 From the Automation Center navigation pane, select Tasks > Manual Tasks. The Manual Tasks list displays.
Step 2 Right-click the Pause for Manual task and, on the Action menu, select Launch Task.

Step 3 Display the Activity Monitor. It will list the Pause for Manual task instance, in Action Required status, and the Monitors for
Problems Task Monitor task, which was launched when enabled the Controls Monitor for Problems triggered

Dashboards [ Activity [ | Manual Tasks [

23 Task Instances -|Last48hours ~ | [4 No quickfilter ~ || Custom Filter|— None — v | ' Filter
Instance Name Type Status Invoked By Start Time End Time Updated ™ v

[=] Pause for Manual Manual Action Required Wanually Launched 2014-08-05 14:09:26 -0400 2014-08-05 14:09:28 -0400

EI Monitors for Problems ~ Task Monitor Running Trigger: Controls Monitors for Problems 2014-08-05 14:08:57 -0400 2014-09-05 14:08:57 -0400

Step 4 Right-click on Pause for Manual to display an Action menu of actions currently available for this task instance.

Step 5 Click Cancel. Pause for Manual goes to Cancelled status and an Email task is launched by the Task Monitor trigger.

Dashboards [ Activity 1 | Manual Tasks

24 Task Instances -|Last48 hours = | [44No quickfilter » | Custom Filter — None — v | B Filter
Instance Name Type Status Invoked By Start Time End Time Updated ™ v

B Triggered by Task Status Email Success Trigger: Controls Menitors for Problems 2014-09-05 14:19:31 -0400  2014-09-05 14:19:32 -0400  2014-09-05 14:19:32 -0400

E‘ Pause for Manual Manual Cancelled Manually Launched 2014-09-05 14:09:26 -0400  2014-09-05 14:19:31 -0400  2014-09-05 14:19:31 -0400

EI Monitors for Problems  Task Monitor Running Trigger: Controls Monitors for Problems 2014-09-05 14:08:57 -0400 2014-09-05 14:19:31 -0400

Step 8 Check the Email account where you sent the notification.
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Step 9 Once the user receives the email, the user can quickly check for more information by looking at the Activity Monitor using the
Cancelled Task Instances filter and clicking on the Instance Name of the problem task. As shown in the illustration below, additional
information about the issue is displayed in the Status Description field.

| Manual Task Instance Details: Pause for Manual = (=] [

Manual Task Instance

— General

Virtual Resources | Exclusive Requests Notes.

5] Update 3 Re-run

o View Parent ¢ Delete

4 Refresh 3£ Close

Instance Name
Task
Task Description

Business Senices
Virtual Resource

Pause for Manual

|

Pause for Manual

Reference |d:

Invoked By :

1

Manually Launched

AManual task run at 2014-08-05 14:09:26 -0400|

IMember of

Execution User:

Hold Resources on

ops.admin

Duration

Priority 10 e Failure : O
— Status
Status - | Cancelled
- State was cancelled from ACTION REQUIRED to CANCELLED
Status Description
Start Time : | 2014-09-05 14:09:26 -0400 End Time :|2014-09-05 14:19:31 -0400

— Time Options

Late Finish Late Finish Type : | Duration
o Late Finish e
Finished Late Duration - oo 02 oo HH:MM:S5
— Statistics
User Estimated Average Estimated ¥ o
End Time End Time - 2014-09-05 14:09:26 -0400
Shortest Estimated Longest Estimated
End Time End Time :
[l update [ Re-run [ View Parent i Delete 5| Refresh ¥ close

For additional information, see:

Email Task

Email Connections
Email Templates
Reports

Activity Monitor
Task Monitor Task

All Task Instances Table (ops_exec)

Task Monitor Trigger
Command Quick Reference
Cancelling a Task Run
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Tutorial - Launching Tasks Using a Cron Trigger

Create a Cron Trigger

Step 1
Step 2

® Name = Launch Tasks Using Cron
® Task(s) = Timerl, Timer2, and Timer3 Timer tasks

® Minutes = Number of minutes past the hour you want the tasks to run. For example, if you want the tasks to run at for 3:16,

enter 16.

® Hours = Hour (in 24-hour time) that you want the tasks to run. For example, if you want the tasks to run at for 3:16, enter 15.

Opswise Controller uses the time zone of the Controller server.

Step 3

Keep the asterisks ( *) in the remaining fields and click the Save button.

From the Automation Center navigation pane, select Triggers > Cron Triggers. The Cron Triggers list displays.

Click the New button to display Cron Trigger Details for a new trigger and enter/select the following values:

v

Cron Trigger

Cron Trigger Details: Launch Tasks Using Cron

Variables Versions

[ Update @& Enable (L3 Trigger Mow [] ListQualifying Times... [l Copy £ Delete

[ =]{p-4

5 Refresh 3% Close

— General

Business

Mame : Launch Tasks Using Cron

Description :
Member of

Senvices
Calendar : |System Default

Timer1
Timer2

Taskis): Timer3

aE|

FIE

Version : 1

Time Zone : System (US/Eastern)

— Status

Forecast: [7]

Skip Count: 0
Skip Trigger if S|

Active

Simulate - |- System Default —

Status : | Disabled

Day

— Cron Details

Minutes : 50
Hours : 16

of Month : *
Month : *

Day of Week : *
Cron Criteria: |50 16 =~

— Restrictions
Special Restriction : []

[E] upd

ate &4 Enable

(& Trigger Now | | [ List Qualifying Times...

Cry copy

i Delete % Refresh

3 Close

Step 4

In the Cron Triggers list, right-click Launch Tasks Using Cron and click Enable.

Step 5 Open the Activity Monitor to see that Timerl, Timer2, and Timer 3 are run at the selected time.

For additional information, see:

® Cron Trigger
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Tutorial - Aborting a Process Launched by a Task

You can use an Abort Actions to instruct Opswise Controller to abort a process under certain conditions. For example, you may want to abort a
task if it is running too long.

In this tutorial, we will set a Timer task to run for 60 seconds and specify an Abort Action when the task runs 45 seconds.

Step 1  Open the Timerl task created in the Creating a Simple Workflow tutorial and enter / select the following values:

Time in Seconds = 60

Late Finish = enabled

Late Finish Type = Duration
Late Finish Duration = 00:00:45

Timer Task Details: Timer1

=3[
[F] Update [S] LaunchTask (@ View Parents [y Copy i Delete |4 Refresh $£ Close
Timer Task Variables Actions Virtual Resources | Mutually Exclusive Instances Triggers Notes Versions
— General
Task Name : Timer1 Version : 5
Task Description :
Member of [ ations, Tech Support v

Business Semvices :
Hold on Start: [7]

Virtual Resource 10 - Hold Resources on B
Priority : Failure :
— Timer Details

Timer Type : | Seconds ¥

Time in Seconds : 60

— Time Options
Late Start: [7]
. Late Finish Late Finish s
Late Finish Type Duration v Duration - (00 || [00 [ | [45 v [HHukSS
Early Finish: [7]
User Estimated . hamss
Duration
— Statistics
First Time Ran : |2014-08-11 14:53:04 -0400 L°W95“”5Ttianqg9 10 Seconds
Last Time Ran : |2014-08-12 10:56:30 -0400 Average '”STt?m”Z"f 10 Seconds
LastInstance [jpac oo Highest Instance [ g0 oo
Duration Time
Number of
. 2
Instances :
[E] update [Zl Launch Task| |[&y View Parents Cly copy % Refresh 3 close

Step 2 Click the Actions tab to display the Actions list.

Step 3 Click Abort Action to display the Abort Action list.
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Step 4 Click New to display Abort Action Details for a new Abort action, enable On Late Finish, and click Save.

Abort Action Details = |[E]]
[E] save 3 Close

Abort Action

— Action Criteria

Status w

Exit Codes:

On Late Start:
On Late Finish
n Early Finish :

oFO

Description :

— Action Details

Cancel Process if

Active : | Qverride Exit Code :

[E] save 3 Close

Step 5 Click the Timer Task tab and then click the Update button.
Step 6 Right-click Timerl in the Timers Tasks list and click Launch.

Step 7 Navigate to the Activity Monitor and verify that after running for 45 seconds, the task instance status changes from Running to
Finished.
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Step 8 Open the task instance Details and note the status description indicates:

State was forced from RUNNI NG to FI NI SHED

Timer Task Instance Details: Timer1 = |[=] [

[ Update 3 Re-run | ViewParent 5 Delete |[% Refresh 3£ Close

Timer Task Instance | Virtual Resources | Exclusive Requests MNotes
— General
Instance Mame : |Timer1 Reference Id : 3
Task: [Timer1 & Invoked By : | Manually Launched

Task Description :

Member of

Business Services - Operations, Tech Support Execution User : |ops.admin
Virtual Resource Hold Resources on
Priority : 10 e Failure : o

— Status
Status : |Finished

... State was forced from RUNNING to FINISHED
Status Description :

Start Time : | 2014-08-12 14:39:02 -0400 End Time : | 2014-08-12 14:39:47 -0400
Duration : |45 Seconds

— Timer Details
Timer Type : |Seconds v
Time in Seconds : 60
r— Time Options
Late Finish - Late Finish Type : Duration
. . Late Finish —
Finished Late : Duration - oo oo 45 HH:MN:SS
— Statistics
User Estimated Average Estimated y 2919
End Time - End Time - 2014-08-12 14:39:12 -0400
Shortest ESimated (5014 4512 14:30:12 -0400 Longest Estmated (1 na 12 14:30:12 -0400
End Time End Time
[E] update [ Re-run o View Parent i Delete 4| Refresh # close

For additional information, see:

® Setting Up Abort Actions
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Tutorial - Force Finishing, Force Finish-Cancelling, and Cancelling a
Task

In this exercise, we will force finish, force finish/cancel, and cancel tasks within a workflow from three areas:
® Workflow Monitor
® Activity Monitor
® Task Instances list

You can run any of these three commands from any of these three areas. For stand-alone tasks, you can run these commands only from the
Activity Monitor and Task Instances list.

', Note
You can force finish, force finish/cancel, and cancel any task in Running status, but you only can force finish a task in Waiting
status. See Manually Running and Controlling Tasks for a complete list of task statuses for each command.

Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks list displays.

Step 2 Create a Workflow with an Agent-based task, such as a File Monitor task, that can be Force Finished, Force Finish / Cancelled, and
Cancelled. (See the Creating a Simple Workflow tutorial for help on creating the Workflow.)

Step 3 Click Launch Task to run the Workflow.
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Step 4 Force Finish a task from the Workflow Monitor:

1. From the Automation Center navigation pane, select Task Instances > Task Instances to display the Activity Monitor which
displays, by default, a list of Active Task Instances.

2. Click Simple Workflow to display its Workflow Monitor.

3. Right-click a Waiting task and, from the list of Commands on the pop-up menu, click Force Finish. The status of the task
changes from Waiting to Finished, and all successor task instances waiting for successful completion of this task instance will
start.

stonebranch-timertask-01
Success

e —

View/Edit

stonebranch-file

Runnin Commands L
Insert Task Az Predecessor... Force Finish (Halt) k-01
Inzert Task As Successor.. Force Finish/Cancel

Force Finizh/Cancel (Halty

Properties

Step 5 Force Finish/Cancel a task from the Activity Monitor:

1. Return to the Activity Monitor.

2. Right-click a Simple Workflow task that is in the Running status and, on the Action menu, click Force Finish/Cancel. The
status of the task changes from Running to Finished, and all successor task instances waiting for successful completion of
this task instance will start.

Dashboards [ || Actvity ] | Workflow Tasks ]

70 Task Instances

Ingtance Mame Type Status

E| stonebranch-filemonitor-02 File Monitor Running
stonebranch-tir IZ/I[ Timer SUCCESS
stonebranchtir & Force Finish ’ Force Finish

Email Tutorial | &9 Cancel Force Finish (Halt)

Email Tutorial

=y

Farce FinishiCancel %
Farce FinishiCancel (Halt)

[0 [0 [ [0 [0

I
stonebranch-wi o) unning

P
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Step 6 Cancel atask from the Task Instances list:

1. From the Automation Center navigation pane, select Task Instances > Task Instances to display the Task Instances list.

2. Right-click a Simple Workflow task in the Running status and, on the Action menu, click Cancel. The status of the task
changes from Running to Cancelled, and all successor task instances waiting for successful completion of this task will
remain in the Waiting status. The status of Simple Workflow changes from Running to Running/Problems.

Dashboards [] || Task Instances [] | Workflow Tasks ]
% 71 Task Instances

Instance Mame ™ Type Status
E| stonebranch-workflow-03 Workflow Running
E| stonebranch-timertask-02 Timer SUCCESS
El stonebranch-timertask-01 Timer SuCCess
El stonebranch-timertask-01 Timer SuCCess
El stonebranch-timertask-01 Timer Success
E| stonebranch-timertazk-01 Timer
E| stonebranch-filemonitor-02 File Monitor Running
El Sleep 60 @ g Timer SuCCess
El Sleep 5 @@ Force Finish ¢ Timer SuCCess
El Sleep 30 @ Daﬁm Timer Success
==| Sleen 30 N L Tirner Slccees

For additional information, see:

Force Finishing a Task

Cancelling a Task

Force Finish / Cancelling a Task

Monitoring Activity from the Activity Monitor
Monitoring Activity from the Task Instances List
Monitoring Workflows
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Tutorial - Accessing Task Instance Details

Step 1 From the Automation Center navigation pane, select Task Instances > Activity to display the Activity Monitor.

Step 2 Click the Instance Name of any task instance to display its Task Instance Details. For example:

Timer Task Instance Details: Timer1 =||B=|[%

5] Update (3 Re-run ¢ Delete || Refresh 3£ Close

Timer Task Instance | Virtual Resources | Exclusive Requests MNotes
— General
Instance Mame : |Timer1 Reference Id : 2
Task: [Timer1 & Invoked By : | Trigger: Trigger A
Task Description :
Memper UT Operations, Tech Support Execution User: ops.admin
Business Semvices :
Virtual Resource 10 = Hold Resources on D

Priority : Failure :

— Status
Status : |Success

Status Description :

Start Time : |2014-08-12 10:56:30 -0400 EndTime : | 2014-08-12 10:56:40 -0400

Duration : |10 Seconds

— Timer Details
Timer Type : | Seconds v
Time in Seconds : 10
— Statistics
User Estimated Average Estimated ¥ Fr—
End Time : End Time - 2014-08-12 10:56:40 -0400
Shortest EStMAted |5014-0g-12 10:55:40 -0400 Longest Estimated 5514 5512 10.56.40 0400
End Time End Time

[E] update [ Re-run o View Parent i Delete 4| Refresh 3 Close

Task Instance Details contain many fields not displayed in the Task Details for this task that provide information about this run
(instance) of the task and all runs of the task, including the first time it was run; the last time it was run; the number of times it has run;
and the least, average, and most amount of time it has ever taken to run.

Step 3 To view all details stored in the All Task Instances table (ops_exec) for this task instance, right-click anywhere in the Task Instance
Details to display an Action menu and then click Details > Show Details.
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/

Home [] | Timert [

Timer Type:

Seconds

Time in Seconds:

10

Viait Until Time:

00:00

Duration:

00:00:00

Class:

ops_exec_sleep

Task Name:

Timer1

Task:

Timer1

Instance Name:

Timer1

Task Description:

Invoked By:

Trigger: Trigger A

Queued Time:

State Changed Time:

2014-08-12

Start Time:

2014-08-12

End Time:

2014-08-12

CPU Time:

10 Reads:

10 Virites:

10 Other:

Memory Used:

Memory Peak:

o
o
o
o
o
o

Task Priority:

WEDIUM

Exit Code:

o

Status Description:

Reference Id:

Status:

Success

Type:

Timer

Resources State:

Virtual Resource Priority:

Agent Name:

Agent:

Workflow Definition Name:

Workflow Definition:

Workflow Name:

Wiorkflow:

Workflow:

Viorkflow Start Time:

Trigger Name:

Trigger A

Trigger:

Trigger A

Vertex Id:

Run Called:

Forced Finished:

Shortest Estimated End Time:

2014-08-12

Average Estimated End Time:

2014-08-12

Longest Estimated End Time:

2014-08-12

User Estimated End Time:

Duration:

10 Seconds

Duration In Seconds:

10

Credentials Name:

Credentials:

Credentials Unresolved:

Credentials Variable:

Maximum Retries:

Current Retry Count:

Retry Indefinitely:

Retry Interval (Seconds):

Attempt:

of il Services:

op , Tech Support

Services:

] , Tech Support

Security Name:

Timer1

Execution User:

‘ops.admin

Late Start:

Late Start Type:

Time

Late Start Time:

00:00

Late Start Duration:

Started Late:

Late Finish:

Late Finish Type:

Late Finish Time:

Late Finish Duration:

Finished Late:

Early Finish:

Early Finish Type:

Early Finish Time:

Early Finish Duration:

Finizhed Farl:

0ps-61x-t&t




Opswise Controller 6.1.x Troubleshooting and Tutorials
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/

Calendar Name:

System Default

Calendar:

System Default

Run Criteria Trigger Time:

Run Criteria Run Time:

Hold on Start:

Hold Reason:

Waited for Resources:

Hold Resources on Failure:

Resources Consumed:

Exclusive State:

Waited for Exclusive:

Launch Time:

2014-08-12

Agent Acquired Name:

Agent Acquired:

Agent Cluster Acquired Name:

Agent Cluster Acquired:

Progress:

All Dependencies Cleared:

uuiD:

f9283383df7943d093171019a60649a3

Created:

2014-08-12

Created By:

‘ops.admin

Updated:

2014-08-12

Updated By:

‘ops.admin

Table Name:

0ps_exec_sleep

Is Version:

false

Can Update:

true

Can Delete:

true

® Left column shows each field in the All Task Instances table for this task instance.
® Right column shows the current value for each field for this task instance.
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Tutorial - Monitoring Task Activity

® Starting and Stopping the Activity Monitor
® Apply Time Constraints and Filters to the Activity Monitor
* Apply Display Settings to the Activity Monitor

In this tutorial, we will monitor task activity from the Activity Monitor.

We will start and stop the Activity Monitor, apply time constraints and filters to the task instances displayed on the Activity Monitor, and apply
display settings to the Activity Monitor.

Starting and Stopping the Activity Monitor

By default, the Activity Monitor does not automatically monitor Opswise Controller activity when you log in. You must start the Activity Monitor to
see task activity.

(You can allow the Activity Monitor to automatically monitor Controller activity when you log in by changing the Activity Monitor Automatically user
preference.)

Step 1 From the Automation Center navigation pane, select Task Instances > Activity. The Activity Monitor displays.

Dashbeards Activity
-|Last48 hours « % Mo quick filter = | Custom Filter — None — v '@ Filter...
Instance Nams Type Status Invoked By Start Time End Time Updated -~
(»)
Click to start the Activity monitor
Start Stop

1 m »
56 Settings K 4 3 B Page of
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Step 2  To start the Activity Monitor, either:

1. Click the Click to start the Activity monitor button in the middle of the Activity Monitor.
2. Click the Start Activity monitor button at the bottom of the Activity Monitor.

The Activity Monitor then displays a list of all current activity.

Dashbeards Activity
646 Task Instances -|Last48 hours - % Mo quick filter « | Custom Filter - None —
Instance Name Type Status Invoked By Start Time End Time:

I:I lecu-wkfl-sleep Workflow Success Manually Launched 2014-09-02 12:57:55-0400  2014-09-02 12:58:36 -0400
I:I sleep 10 Timer Success Workflow: lecu-wkfl-sleep 2014-09-02 12:58:26 -0400  2014-09-02 12:58:35 -0400
I:I Sleep 30 Timer Success Workflow: lecu-wkfl-sleep 2014-09-02 12:57:56 -0400  2014-09-02 12:58:26 -0400
I:I Sleep 0 Timer Success Workflow: lecu-wkfl-sleep 2014-09-02 12:57:56 -0400  2014-09-02 12:57:56 -0400
I:I Sleep 60 Timer Workflow: lecu-wkfl-sleep 2014-09-02 12:57:55 -0400
I:I Sleep 60 Timer Workflow: lecu-wkfl-sleep 2014-09-02 12:57:55 -0400
I:I Sleep 60 Timer Workflow: lecu-wkfl-sleep 2014-09-02 12:57:55 -0400
I:I Sleep 30 Timer Workflow: lecu-wkfl-sleep 2014-09-02 12:57:55 -0400
I:I Sleep 30 Timer Workflow: lecu-wkfl-sleep 2014-09-02 12:57:55 -0400
I:I win-exit-code Windows Faile Manually Launched 2014-09-02 12:44:03 -0400  2014-09-02 12:44:03 -0400
I:I zos-workflow-regression-test Workflow Success Manually Launched 2014-09-02 11:52:47 -0400  2014-09-02 12:10:30 -0400
I:I zos-workflow-simple-load-test-01  Workflow Success Workflow: zos-workflow-regression-test 2014-09-02 11:55:39 -0400  2014-09-02 12:10:30 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:28 -0400  20114-09-02 12:10:29 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:25-0400  20114-09-02 12:10:26 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:23 -0400  20114-09-02 12:10:23 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:20 -0400  20114-09-02 12:10:20 -0400
I:I zos-workflow-simple-load-test-02  Workflow Success Workflow: zos-workflow-regression-test 2014-09-02 11:58:39 -0400  2014-09-02 12:10:19 -0400
I:I zos-task-load-simple-02 z/0s Success Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:17 -0400  20114-09-02 12:10:17 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:15-0400  20114-09-02 12:10:15 -0400
I:I zos-task-load-simple-02 z/0s Success Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:12 -0400  20114-09-02 12:10:12 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-08-02 12:10:11 -0400  2014-09-02 12:10:11 -0400
I:I zos-workflow-simple-load-test-03  Workflow Success Workflow: zos-workflow-regression-test 2014-09-02 11:55:39 -0400  2014-09-02 12:10:13 -0400
I:I zos-task-load-simple-03 z/0s Success Workflow: zos-workflow-simple-load-test-03 2014-09-02 12:10:09 -0400  20114-09-02 12:10:09 -0400
I:I zos-task-load-simple-02 z/0s Success Workflow: zos-workflow-simple-load-test-02 2014-09-02 12:10:07 -0400  20114-09-02 12:10:08 -0400
I:I zos-task-load-simple-01 z/0s Success Workflow: zos-workflow-simple-load-test-01 2014-09-02 12:10:06 -0400  20114-09-02 12:10:08 -0400
1 m

15 settings ~ |T‘ & K q Next Last B Page

1

v 53 Filter...
Updated ™ -
2014-09-02 12:58:38 -0400
2014-09-02 12:58:35 -0400
2014-09-02 12:58:28 -0400
2014-09-02 12:57:58 -0400
2014-09-02 12:57:55

2014-09-02 12:57:

2014-09-02 12:57:55

2014-09-02 12:5T7:

2014-09-02 12:44:03 -0400
2014-09-02 12:10:30 -0400
2014-09-02 12:10:30 -0400
2014-09-02 12:10:30 -0400
2014-09-02 12:10:27 -0400
2014-09-02 12:10:24 -0400
2014-09-02 12:10:21 -0400
2014-09-02 12:10:19 -0400
2014-09-02 12:10:19 -0400
2014-09-02 12:10:19 -0400
2014-09-02 12:10:15 -0400
2014-09-02 12:10:14 -0400
2014-09-02 12:10:13 -0400
2014-09-02 12:10:13 -0400
2014-09-02 12:10:11 -0400
2014-09-02 12:10:10 -0400

ue | OF 26

Step 3  To stop the Activity Monitor, click the Stop Activity monitor button at the bottom of the Activity Monitor.

Apply Time Constraints and Filters to the Activity Monitor

(You can select apply any time constraint for any combination of multiple filters for the list of task instances on the the Activity Monitor.)

Step 1 = Select a time frame of task activity to display on the Activity Monitor by clicking the Time Constraint button and selecting a time fame
from the menu. The default is Last 48 hours, which means that the Activity Monitor will display only task activity that occurred in the
last 48 hours.

Step 2 = Click the Quick Filter button to display a menu of simple, pre-defined filters that you can apply to the list, such as a specific task type of
specific task instance status. You can apply as many Quick Filters as you like to the list.

Step 3  Click the Clear button at the bottom of the Quick Filter menu to remove all Quick Filters from the list.

Step 4 Click the Filter button to select a Custom Filter of complex, user-defined filter that you can apply to the list, such as only task instances

that belong to a specific Business Service.

Apply Display Settings to the Activity Monitor

Step 1 = Click the Settings button at the bottom of the Activity Monitor to select:

® Number of task instances to display on each page of the Activity Monitor.
® Refresh rate for the dynamic data displayed on the Activity Monitor.
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Step 2 Click the First, Prev, Next, and Last buttons at the bottom of the Activity Monitor to navigate through multiple pages of activity.

Step 3 Click the ellipse ( ... ) button at the bottom of the Activity Monitor to select a specific page of activity to display.
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Tutorial - Creating a Simple Workflow

® [ntroduction

® Create and Copy Tasks

® Creating a Simple Workflow
® Running the Workflow

Introduction

In this tutorial, we will learn how to copy tasks, create a simple Workflow of Timer tasks, and use the tools available in the Workflow Editor.

Create and Copy Tasks

Create a Timer task and make five copies for use in the Workflow. Use the names Timer1l through Timer6, and assign each task a time of 10
seconds.

1. Note
You can copy tasks using different methods. One method is provided below.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Tasks. The Timer Tasks list displays.
Step 2 In the Timer Task Details below the list, create Timerl and click Save.

Step 3 Change the Task Name from Timerl to Timer2, right-click the Details to display an Action menu, and click Insert to make a copy of
the Timerl task named Timer2.

Dashboards [] | Timer Tasks []
A 62 Timer Tasks Custom Filter — Mone — v | 5% Fiter. [ CoTo.. | @ New | &
v Timer Task Details [ update [T] New [S! Launch Task |g&5 View Parents ) Copy (i Delete ||5 Refresh
Timer Task Variables Actions Virtual Resources | Mutually Exclusive Instances Triggers Notes Versions.
— General
Task Name : Timer2 [ Launch Task
Task Description : [ Launch Taskwith Variables..
Member of -
Business Senices : El Update
Hold on Start: [7] o Insert
Virtual Resource H
Priorily - 10 % [T New
Cr copy
— Timer Details
Timer Type : | Seconds ¥ &5 View Bundles
Wait Time n &1 Add To Bundle..
Seconds: 5| Promote...
— Time Options
? Reset Statistics
Late Start: [
Late Finish : Late Finish Duration View P 1t v | |45 | |HH:MM:SS
: Type &5 View Parents LR
Early Finish: [
»
= Delete
User Estimated v v v | HH:m:s3 d
Duration :
@ Details »
[E] Update ] Mew [= Launch Task| |[&5 View Parents Cr Copy % Refresh

Step 4 Repeat Step 3 for Timer3 through Timer6.

Creating a Simple Workflow

Now that we have six Timer tasks, we are ready to create a simple workflow.
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(See Creating and Maintaining Workflows for detailed information on the tools and icons used in this procedure.)

Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks List displays.
Step 2 In the Workflow Task Details below the list, enter Simple Workflow in the Task Name field and then click the Save button.

Step 3 Click the Edit Workflow button to display the Workflow Editor.

Administrator ~ &5 = @

Workflow Tasks Workflow Editor

GIoERBIRON Ao bBEXA8884 (2L BSE

By default, the Workflow Editor displays in Select mode, which lets you select tasks for the Workflow.

(See Workflow Editor Icons for a description of each icon on the toolbar.)
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Step 4

Click the Add Task % icon. The Task Find pop-up dialog displays.
Task Find (=] x]
Task Name: All Task Types j Search |
| | Task Type Task Mame
l | ol

Step 5 Select Timer in the drop-down list and click the Search button. A list of all Timer tasks displays.

/
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Step 6 Drag and drop the icon for Timerl onto the Workflow Editor canvas, and repeat for Timer2 through Timer6.

Workflow Tasks ] | Workflow Editor [

dtoHEIBIEm - lonlsBaXxladasalssBen

Task Find =X
G Task Name: Timer Timer | Search
G G [ Task Type Task Name
Timer1
Timer2 : G Timer Timer1
Timer3 O Timer Timer2
e Timer Timer3
G Timer Timerd
G Timer Timers
Timerd G © Timer Timerg
Timers 5
Timer6
4 i

Workflow Name: Simple Workflow

Step 7 Close the Task Find pop-up dialog.

/
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Step 8 Click and drag the tasks so that Timerl is at the top of the canvas; Timer2, Timer3, and Timer4 are below Timerl; and Timer 5 and
Timer6 are below Timer2, Timer3, and Timer4.

Workflow Tasks [] || Workflow Editor [

Gl S|BIRMS AOMBEX/ARA84 (26| BB

S

Timer1
Timer2 Timer3 Timerd

o ¢

Timers Timer6

Workflow Name: Simple Workflow
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Step 9  Click a Connect Icon to connect the tasks so that Timerl is the top-level predecessor task; Timer2, Timer3, and Timer4 are
successor tasks to Timerl; and Timer5 and Timer6 are successor tasks to Timer3.

Workflow Tasks [ | Workflow Editor

GRS IBRIGM.- /o $BEX| AR 044 BSD

o

Timer1

I
¢ o ¢

Timer2 Timer3 Timerd

7\

¢ ©

Timers Timer6
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Step 10 The default condition (or dependency) for connectors is Success. That is, a successor task runs if its predecessor task goes to
Success. To view the conditions for a successor task, right-click the connector between it and its predecessor task, and then click
Conditions. The Conditions pop-up displays.

Workflow Tasks Workflow Editor
OSBRI T Alow|+BRX|A8804 |54 B
Timer1
Timer2 Ti.rner3 Timer4
Conditions
© Success
i‘  Failurs
© SuccessiFailure
" Exit Code(s)
Timer5 Tim
0K | Cancel
orkfio ame: Simple Workflo
*,  Note

Since a Timer task cannot go to Failure, the Failure and Success/Failure conditions are grayed out.

Step 11 . - . . . .
P Click the Cancel button on the Conditions pop-up, and then click the Save IEI icon in the Workflow Editor task bar to save the

Workflow.

Running the Workflow

Now we will manually launch the Workflow and view it from the Activity Monitor.
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Step 1 Right-click anywhere in the Workflow Editor canvas and, on the pop-up menu that displays, click Launch Workflow.

Workflow Tasks [] | Workflow Editor [2]

flod& BIEM.Slval+dnX

S

Timer1

f
¢ © ¢

Q888 Q|24 B &SE

Timer2 Timer3 Timerd
/ \ View/Edi
G G [l Paste
Timers Timer6
Find In Graph...
Pan To Top

Workflow Name: Simple Workflow

Step 2 From the Automation Center navigation pane, select Task Instances > Activity. You will see six task instances: the Simple
Workflow task, and the six Timer tasks.

77

Home [ | Workflow Tasks [ | Workflow Editor ] | Activity 3
|.-|Last48 hours « | Custom Filter — Nane — b % Filter...

Instance Name Type Status Invoked By Start Time End Time ™
El Timers Timer Success Workflow: Simple Workflow  2014-07-28 11:38:54 -0400  2014-07-281
EI Timers Timer Success Workflow: Simple Workflow  2014-07-28 11:38:54 -0400  2014-07-28 1
EI Simple Workflow Workflow Success Manualy Launched 2014-07-28 11:38:34 -0400  2014-07-28 1
EI Timer2 Timer Success Workflow: Simple Workflow — 2014-07-28 11:38:44 -0400  2014-07-28 1
El Timer3 Timer Success Workflow: Simple Workflow  2014-07-28 11:38:44 -0400  2014-07-28 1
E| Timer4 Timer Success Workflow: Simple Workflow  2014-07-28 11:38:44 -0400  2014-07-28 1
EI Timer1 Timer Success Workflow: Simple Workflow  2014-07-28 11:38:34 -0400  2014-07-28 1

For additional information, see:

/

® Saving, Updating, Deleting, and Copying Records
® Creating Workflows
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Tutorial - Running a Workflow with a Conditional Path

® |ntroduction
® Prerequisite
Create a Timer Task
Create SQL Tasks
Create a Manual Task
Create a Workflow
Run the Workflow to Success
Run the Workflow Down the Conditional Path

Introduction

In this exercise, we will create a short workflow of SQL tasks. We will begin with a two-minute Timer task so that we will have enough time to see
what the Workflow looks like on the Activity Monitor when we launch it. We will also create a conditional path, as follows:

®* The Workflow runs seven days a week and creates a new database table. If that is successful, additional SQL tasks run that insert a
value, select a count, and delete a value. Each subsequent task runs if the previous is successful.

® |f the first (table creation) task fails, the Workflow goes to a Manual task instead of the regular flow. This is the conditional path. The
Manual task creates a pause in the Workflow and sends an Email Notification. A user is expected to check the database and fix the
problem that caused the first task to fail. If the Manual task is set to a Complete status, it goes to Success and the Workflow then returns
to the remaining SQL tasks. While the Manual task remains in the Action Required status, the successor tasks have a Waiting status.

We will also add an Email Notification and a Note to this Workflow.

Prerequisite

Since we are using SQL tasks in this exercise, you will first need to create a SQL Database Connection.

Create a Timer Task

We will add a Timer task at the beginning of our Workflow so that we will have a chance to view it when Opswise Controller loads it into the
Activity Monitor.

Step 1 From the Automation Center navigation pane, select Tasks > Timer Tasks. The Timer Tasks list displays.
Step 2 Click New to display an empty Timer Task Details and enter / select the following values:
® Task Name = Two Minute Timer

® Timein Seconds =120

Step 3 Click the Save button.

Create SQL Tasks

In this exercise, we will create SQL tasks that execute the following SQL commands:
® Create a new table in the database.
® |nsert a value into the table.
® Select a count value from the table.
® Delete the value from the table.

Perform the following steps to create the SQL tasks:

Step 1 From the Automation Center navigation pane, select Tasks > SQL Tasks. The SQL Tasks list displays.
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Step 2 Click New to display an empty SQL Task Details and enter / select the following values:
® Task Name = SQL Create Table

® Database Connection = (the database connection you created as a prerequisite)
® SQL Command = CREATE TABLE opswise_tut${ date("yyyyMMdd",5)} (name varchar(128), value varchar(128));

Step 3 Click the Save button.

=114

[l save $£ Close

SQL Task Details

SQL Task

— General
Task Name: $QL Create Table Version 1

Task Description

Wember of
Business
Senvices

Hold on Start: [

virtual Resource [ Hold Resources on B
Priority Failure

— SOL Details

Database
Connection :

Database ’
Connection [ Crigﬁgglaela o
Variable

Maximum Rows Auto Cleanup . [7]

CREATE TABLE apswise_tut${_date(yyyMMdd" 5)} (name varchar(128), value varchar(128))]

QA Mysgl Connection » D Credentials ¥ D

3QL Command :

Result

Processing - | SKIP Result Processing -

— Retry Options
WMaximum Retries 0 Retry Indefinitely : []

Retry Interval 60
(Seconds)

— Time Options

Late Start: [7]
Late Finish: [
Early Finish : []

User Estlmgled ~ | HH:MM:55
Duration :

4
<

[E] save ## Close

Step 4 Create a SQL task called SQL Insert Value with this value:

® SQL Command = INSERT INTO opswise_tut${_date("yyyyMMdd",5)} (hame, value) values (‘A', 'F'), (B','S"), ('C', 'F";

Step 5 Create a SQL task called SQL Select Count with this value:

® SQL Command = SELECT count (*) as count FROM opswise_tut${ date("yyyyMMdd",5)} WHERE value = 'F;

Step 6 Create a SQL task called SQL Delete with this value:

® SQL Command = DELETE FROM opswise_tut${ date("yyyyMMdd",5)};

Create a Manual Task

A Manual task is used within a Workflow to create a pause in processing, during which the user must perform some task. When the user task is
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complete, the user sets the Manual task to a completed state and processing continues.

For our Manual task, we are also going to request a warning if the user takes too long to complete it.

Step 1 From the Automation Center navigation pane, select Tasks > Manual Tasks and click New.
Step 2 In the Manual Task Details, enter / select the following values:

Task Name = Pause for Manual

Task Description = A Manual task run at ${ _dat e() } (a variable that indicates the date and time the Manual task launches)
Late Finish = enabled

Late Finish Type = Duration

Late Finish Duration = Hours 00 02 00 (2 minutes)

Step 3 Click the Save button.

i =11p.%

] save 3 Close

Manual Task Details

Manual Task

— General
Task Name : Pause for Manual Version : 1

Task Description © AManual task run at ${_date()}

Wember of .
Business Senvices
Hold on Start: [

Virual Resource [ o Hold Resources on a
Priority Failure :

— Time Options

Late Start: [7]

Late Finish Late Finish 00

Late Finish : Type Duration > Duration

Early Finish: [7]

User Estimated
Duration

v [(02 |w |00 |w HHWM:SS

¥ » w | HH:MM:SS

[E] save 3 close

Step 4 Add a Note:

1. Click the Notes tab and then click New to display Note Details.
2. Enter the following values:

® Title = Probable database problem

® Text = Make sure database is running.

3. Click Save.
Note Details | [=]{B2s
[ save 3£ Close
Note
— Details =

Title : Probable database problem

Make sure database is running

Text:

[l save 3 close
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Step 5 Add an Email Notification:

. Click the Actions tab.

HWOWN P

. Click Email Notification in the list of Action types.
. Click the New button to display Email Notification Details for a new Email Notification.
Enter / select thew following values:

® Status = ACTION REQUIRED

Step 6 Click the Save button.

Email Connection = (the Email Connection you created earlier)
To = (your Email address)

Subject = Issue with Workflow
Body = ${ date} workflow failure; notification triggered by ${ops_task_name}

Manual Task Details

Manual Task

=[O

[l save 3 Close

— General

Task Hame : Pause for Manual

Task Description © A Manual task run at ${_date()}
Member of
Business Services
Hold on Start: [7]

Virtual Resource 10
Priority

Version : 1

Hold Resources on
O

Failure :

— Time Options
Late Start: [

Late Finish :

Early Finish : [7]

User Estimated

NS5
Duration : e ¥ | HH:MM:

Late Finish Duration
Type

- Late Finish 00 |« o2 [« (o0

MM:SS
Duration » | HH:MM:

E) save # Close

Create a Workflow

Create a Workflow containing the Timer, SQL, and Manual tasks that you just created.

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

® Task Name = SQL Workflow

In the Workflow Task Details, enter the following value:

From the Automation Center navigation pane, select Tasks > Workflow Tasks and click New.

In the Workflow Editor, use the Add Task tool to drag the tasks you just created onto the canvas.

1. Right-click the connector between SQL Create Table and Pause for Manual.
2. On the pop-up menu, click Conditions.

3. On the Conditions pop-up dialog, enable Failure and click the OK button. Note that the connector is a dotted line, which

indicates a Failure connection.

| ops-61x-t&t

Click the Save button, right-click SQL Workflow on the Workflow Tasks list, and then click Edit Workflow on the Action menu.

Organize the tasks and create connections as shown in the following illustration. The Success connectors tell the Controller that if SQL
Create Table goes to Success, run Insert SQL Value and the other SQL tasks.

Create a conditional path specifying that if SQL Create Table fails, the Controller should run the Pause for Manual task:
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Step 7 On the Workflow Editor toolbar, click the Save icon.

Two Minute Timer

Q - » G » & » || &
50L S0L s0L S4L
SQL Create Table SQAL Insert Value SQL Select Count SQL Delete

?—

Pause for Manual

Run the Workflow to Success

We are going to launch our Workflow and view it from two different perspectives: from the Activity Monitor and the Workflow Monitor.

Step 1 Launch the workflow manually.

Step 2 Display the Activity Monitor. Because the Two Minute Timer task is still running, your display should look similar to this:

Dashboards [] | Activity [ | Workflow Tasks [}

39 Task Instances “|Lastd8 hours = | [ Mo quickfilter = | Custom Filter — Mane — ~ | S Filter..
Instance Name Type Status Invoked By Start Time v

EI SOL Select Count saL Workflow: SQL Workflow

EI SOL Create Table saL Workflow: SQL Workflow

EI Pause for Manual Manual Workflow: SQL Workflow

EI S0L Delete saL Workflow: SQL Workflow

EI S0L Insert Value saL Workflow: SQL Workflow

EI Two Minute Timer Timer Running Workflow: SQL Workflow 2014-08-22 15:42:21 -0

EI S0L Workflow Workflow Running Manually Launched 2014-08-22 15:42:20 -0

Step 3 Right-click SQL Workflow on the Activity Monitor list to display an Action menu and select Workflow Task Commands > View
Workflow. The Workflow Monitor opens and shows progress on the task. The Workflow Monitor updates automatically with each
status change.
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\C

Two Minute Timer

Success
& m—— [} > le S
50L 50L SQL SaL
5QL Create Table SQL Insert Value SQL Select Count SQL Delete
Finished

i

Pause for Manual
Action Required

When the Timer task finishes, the SQL tasks execute. All tasks go to Success and the workflow goes to Success. The only task that
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did not run is the conditional task, Pause for Manual.

Sleep 2 Minuntes
Success
o Q G Q
5aL)y———» 54L » 5QL)—— 58L
SOL Create Table SOL Insert Value S0OL Select Count SOL Delete
SucCess Success Success Success

=
Pause for Manual
Skipped

Run the Workflow Down the Conditional Path

Recall that we inserted a date variable into the INSERT TABLE command. Thus, you can run this workflow every day and get a new table name
each day, based on the date. For the purposes of our exercise, assuming you are performing it on the same day you did the previous exercise,
the SQL Create Table task will fail this time because the table already exists.

Step 1 Return to the Bigger Workflow task and launch it again.

84 | ops-61x-t&t



Opswise Controller 6.1.x Troubleshooting and Tutorials

Step 2 From the Activity Monitor, click the Workflow name to view it from the canvas. This time, the workflow goes down the conditional path. N
that when you set up a conditional path, what would normally be a Failure status for the SQL Create Table task becomes a status of
Finished. If you ran this task as a standalone task or without the conditional path, its status would say Failed.

Sleep 2 Mimnes
Success
= [ [ [
SQL{—————» SgL —mm» QL —m———» SOL
SCL Create Table SOL Insert Value SOL Select Count SOL Delete
Finished
I 1*&" il

R s P
Pause for Manual

wetion Reouired

Step 3 When the Pause for Manual task launches, it generates the Email Notification we added earlier.

frorn  opswise.testagmail.com hide details 5:32 PM ([0 minutes ago) | 4 Reply | ¥
to @ canneturn@amail.com
date  Man, Aug 17, 2009 at 5:32 PM
subject  lssue with Bigger Workflow
mailed-by  gmail.cam
signed-by  grnail.com

2009-08-17 18:31:585 -0700 workflow failure; notification triggered by Pause for Manual

& Reply = Forward S nvite apswise test@gmail.com to chat

Step 4 The user receives the email, which provides the name of the task that generated it (Pause for Manual in our case). The user might also |
running a special Activity Monitor that displays only Manual tasks in the Action Required status. According to our scenario, the user oper
the Pause for Manual task and checks the Notes to find out what action he or she is supposed to take. In our case, the Notes say to che
the database and bring it back up.

Step 5 At this point, the workflow processing could continue in either of two ways:
1. Re-run the task that failed and send the workflow down the success path.

2. Set the Pause for Manual task to Completed status and continue the workflow from there.
We will try both methods.
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3. Re-run the failed task; right-click the task and select Commands > Re-run. In a real processing situation, this is the method yot
would use because you need to create the table before you can continue.
a. Right-click the task that failed and select Commands > Re-run.

Sleep 2 Mimnes
Success

Commands

Pause for Manual

Note that we are still on the same day so the task fails again because the table already exists. In a real processing
situation, the task would go to Success and the subsequent tasks would run as expected.
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4. Set the Manual task to Complete status. For the purposes of our exercise, we will get the workflow going again by setting the
Manual task to complete.
a. Right-click the Manual task.
b. Select Commands > Set Completed.

Cancel

Force Finish
A ghion § i Set Started
Set Completed

The Manual task goes to Success and the rest of the workflow runs.

Sleep 2 Mimuntes

SUcCcess
[ E o o
SQLfp——7> saLy—m™@ sqLjp—m—> S5AL
SOL Create Table SOL Insert Value SOL Select Count SOL Delete
Finished Success Success Success

Console |5 .

Monday, August 17, 2009 1:09:31 PM: Command Zet Completed executed
successiully against tazk instance Pause for Manual.

F"au:se for Manual
poUGgessy

| Clear | //:-

c. Because we set a two-minute Late Finish flag on our Manual task and we (presumably) took more than two minutes to
complete it, the Manual task has been flagged as a late finish. To view the flag, go to the Activity Monitor and click the
Manual task name. In the task instance Details, an enabled Finished Late field now displays, and the Duration field
indicates the duration of the task.

For additional information, see:

Activity Monitor
Monitoring Workflows
Database Connections
SQL Task

Manual Task

Email Notification Actions
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® Creating Notes
® Creating Conditional Paths
® Adding Skip/Run Criteria
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Tutorial - Running a Workflow with Multiple Conditional Paths

In this tutorial, we will create a Workflow containing tasks with multiple predecessors and multiple successors, and specify different conditional
paths for those tasks.

The Workflow will show that:

® A successor task with multiple predecessor tasks needs only one of the predecessor tasks to be Successful in order to run.
® Tasks are skipped if they are in conditional paths not taken.

Step 1  From the Automation Center navigation pane, select Tasks > Workflow Tasks and click New.
Step 2 In the Workflow Details, name the Workflow Multiple Paths and click the Save button.
Step 3  Click the Edit Workflow button to display the Workflow Editor.

Step 4  Add 10 tasks to the Workflow and specify connections for them, as shown below. (In this example, Email tasks have been added, but
you can add any type of task except Timer tasks, since they have only one type of Conditional path: Success.)

By default, all connections define a Successful condition; if the predecessor task runs to Success, the successor task will run.

'.

Email #2 Email #3 Email #4

n

Email #1 ~ / )

Email #5

Email #7 i
Email #9
Email #8 Email #10

89 / ops-61x-t&t


https://www.stonebranch.com/confluence/display/OWC610/Creating+and+Maintaining+Workflows#CreatingandMaintainingWorkflows-SpecifyingConditionsonConnections
https://www.stonebranch.com/confluence/display/OWC610/Creating+and+Maintaining+Workflows#CreatingandMaintainingWorkflows-SpecifyingConditionsonConnections
https://www.stonebranch.com/confluence/display/OWC610/Navigator#Navigator-AutomationCenter
https://www.stonebranch.com/confluence/display/OWC610/Creating+and+Maintaining+Workflows#CreatingandMaintainingWorkflows-DesigningaWorkflow
https://www.stonebranch.com/confluence/display/OWC610/Creating+and+Maintaining+Workflows#CreatingandMaintainingWorkflows-SpecifyingConnections

Opswise Controller 6.1.x Troubleshooting and Tutorials

90

Step 5

Step 8

Step 9

Create a Failure condition between tasks #2 and #6, #3 and #6, and #6 and #9, as shown below:

Right-click the connection between them,.
Click Conditions on the pop-up menu.
Select Failure.

Click OK.

rPONPE

Connections with Failure conditions displays as dotted lines.

Email #1

#- / ....I. 1 =
1 Email #5

Email #6
Conditions
o Success

g Failure
-."'-' o Success/Failure

Email #7 " Exit Codeis)
Email :

| e o
<

Email #8 Email #10

Launch the workflow.

In the Automation Center navigation pane, select Task Instances > Activity to display the Activity Monitor.
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Step 10 From the list of Task Instances, click Multiple Paths. The Workflow Monitor for that Workflow displays.

Email #2 Email #3 Email #4
Success Success Success

Email #1
Success

Email #5
Success

Email #6
Success
i

Email #7 -
Success Email #9

l Skipped

Email #8 Email #10
Success Skipped

The Workflow Monitor shows that task #6 ran even though the conditions for two of its predecessor tasks (#2 and #3) specified that it
was to run only if those two tasks failed, because the condition for its #5 predecessor task specified that it was to run if #5 ran
successfully, which it did.

It also shows that tasks #9 and #10 were Skipped because the Controller took the Success path for task #6 and ran Tasks #7 and
#8.
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Tutorial - Running a Workflow with Skipped Criteria

® [ntroduction

® Create the Daily Workflow

® Run the Daily Workflow

® Check the Skipped Workflow's History

Introduction

In this exercise, we will create a daily Workflow that includes a task that we want to skip on Fridays. We will also include a Workflow within a
Workflow and later check the skipped status of the skipped Workflow.

Create the Daily Workflow

Step 1 Create a Workflow named Workflow with Skipped and add the following tasks created in the Creating a Simple Workflow tutorial:

® Four Timer tasks: Timerl, Timer2, Timer3, Timer4.
® One Workflow task: Simple Workflow.
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Step 2 Organize the tasks in the Workflow as shown in the following illustration (using all Success conditions) and click the Save icon.

Home [ || Workflow Tasks [ | Workflow Editor £
SloHSBRIEM ./ oaul+BaXlaaaaass B
C0—0—a—¢ o
—
Timer1 Timer2 Simple Workflow - -
Timer3 Timerd
Workflow Name: Workflow with Skipped, Last Saved: 7/28/2014, 2:23:27 PM

Step 4 Right-click Simple Workflow and, on the pop-up menu, click View/Edit Run Criteria. The Task Run Criteria list for Simple Workflow
displays.

Step 5 Click New to display Task Run Criteria Details.

Step 6 Inthe Type field, select Skip Criteria.

Step 7 Select Specific Day(s).

Step 8 Select the current day (that is, if today is Friday, select Fri).

(See Task Run Criteria Field Descriptions for more details.)
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Step 9 Click Save.

Task Run Criteria Details

Task Run Criteria

Type:
Task:

Skip Criteria i
Simple Workflow
Business Day
Holiday
Specific Day(s)

Complex

Variable

O
O
Custom Day: [}
]
]
.3

[E] save Close

«[H

Sunday 7] Monday Tuesday []

Wednesday [ Thursday [7]

Vertex Id : |6 | Simple Workflow

(=63
[l save 32 Close

Friday [7] Saturday [7]

Run the Daily Workflow

Step 1 Right-click anywhere in the Workflow Editor and select Launch Workflow.

Step 2 Display the Activity Monitor and note that the sub-workflow (Simple Workflow) and all its sub-tasks have been skipped, as shown in

the following example. Note also that this did not impact subsequent tasks, which ran as usual.

Home: Activity | Workflow Tasks []

668 Task Instances

Instance Name Type Status
EI Workflow with Skipped Workflow Success
D Timer4 Timer Success
EI Timerd Timer Success
E] Timerz Timer Success
EI Timer1 Timer Success
El Simple Workflow Workflow Skipped
D Timer2 Timer Skipped
EI Timer3 Timer Skipped
D Timer1 Timer Skipped
EI TimerS Timer Skipped
D Timers Timer Skipped
EI Timer4 Timer

|| Last48 hours =

[ No quick filter =

Invoked By

Custom Filter — MNone —
Start Time

Manually Launched 2014-07-28 15:07:42 -0400
Workflow: Workflew with Skipped 2014-07-28 15:08:13 -0400
Workflow: Workflow with Skipped 2014-07-28 15:08:02 -0400
Workflow: Workflow with Skipped 2014-07-28 15:07:52 -0400
Workflow: Workflow with Skipped 2014-07-28 15:07:42 -0400
Workflow: Workflow with Skipped

Workflow: Simple Workflow

Workflow: Simple Workflow

Workflow: Simple Workflow

Workflow: Simple Workflow

Workflow: Simple Workflow

Workflow: Simple Workflow

End Time

2014-07-28 15:08:23 -0400
2014-07-28 15:08:23 -0400
2014-07-28 15:08:12 -0400
2014-07-28 15:08:02 -0400
2014-07-28 15:07:52 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07.42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07.42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400

v | 3 Filter..
Updated ™ h
2014-07-28 15:08:23 -0400
2014-07-28 15:08:23 -0400
2014-07-28 15:08:12 -0400
2014-07-28 15:08:02 -0400
2014-07-28 15:07:52 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400
2014-07-28 15:07:42 -0400

Check the Skipped Workflow's History

You can view a task instance Details to find out why it has a status of Skipped. On the Activity Monitor, click the Details icon in the first column for

any task instance to display its task instance Details.

For example:
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Workflow Task Instance Details: Simple Workflow - | [E][%

[] update [ Unskip |5 ViewParent |2 ViewWorkflow (& Delete [[% Refresh 3¢ Close

Workflow Task Instance | Virtual Resources | Exclusive Reguests | Step Conditions Notes
— General
Instance Mame : |Simple Workflow Reference Id: 3
Task: Simple Workflow E Invoked By : |Workflow: Workflow with Skipped
Task Description :
. I'v1eml_Jer0T Execution User: jops.admin
Business Senices
Virual Resource Hold Resources on
Priority : 10 b Failure : O

— Status
Status ;| Skipped

Status Description - Skipped due to run/skip criteria.

Start Time End Time : |2014-07-28 15:07:42-0400
Duration :

Progress : |6/6

— Workflow Details
ShowHide Skipped

Tasks - Show Skipped i
— Statistics
User Estimated Average Estimated
End Time : End Time :
Shortest Estimated Longest Estimated
End Time : End Time :
[] update [5 Unskip o View Parent | |2 View Workilow| | (] Delete 5| Refresh 3 Close

Note that the Status Description field indicates that Simple Workflow was skipped due to run/skip criteria. |

For additional information, see:
® Activity display

® Monitoring Workflows
® Adding Skip/Run Criteria
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Tutorial - Finding and Inserting Tasks in an Active Workflow

In this exercise, we will run a workflow and:

® Find a specific task within the workflow. (You also can find a task in a workflow that has not yet been launched or one that has run and
completed.)

® |nsert a task as a predecessor to another task in the workflow.
® |nsert a task as a successor to another task in the workflow.

', Note
You may find it easier to run a workflow three different times, once for each step in this exercise.

Step 1  Create a workflow so that all of its tasks cannot display on the Workflow Monitor at the same time.

Step 2 Right-click in the Workflow Monitor canvas. A pop-up menu displays.

stonebranch-timertask-01
Success

— 1

stonebranch-filemonitor-02

Running Email Tutorial

stonebranch-timertask-02

View/Edit

Commands

Show Skipped/Restore
Hide Skipped

l-_"- -
L

Find In Graph... Email Tutorial

Pan To Top

Insert Task...
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Step 3  Click Find in Graph... to display the Find in Graph dialog.

\C

stonebranch-timertask-01
Buccess

stonebranch-filemonitor-02
Running Email Tutorial

— W — -_——————___+
stonebranch-timertask-02

Find In Graph

Task To Find:

Email Tutorial
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Step 4  In the Task to Find field, enter the name of a task in the workflow that you want to find, and then click OK. Opswise Controller finds
the task in the workflow, highlights the task, and moves the Workflow Monitor display so that the found task is centered on your
screen.

stonebranch-timertask-01
Success

|
|
—
stonebranch-filemonitor-02 1 G
1

Running Email Tutorial s
stonebranch-timertask-02

Email Tutorial
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Step 5

/

Right-click the found task (stonebranch-timertask-02) to display a menu of actions available for that task.

stonebranch-timertask-01

Success

o]

stonebranc
Fu

View/Edit

Commands

View Predecessors/Successors

Inzert Tazk As Predecessor..

Inzert Task As SUCCESSOT..

Properties

stonebranch-timertask-01

Email Tutorial
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Step 6  Click Insert Task As Predecessor.... The Task Insert > Task Selection dialog displays.

Task Insert > Task Selection (=[]
Task Name: stonebranch-manuatask-01 Manual j Search |
| | Task Type Task Mame

< | i

Step 7  Find a task you want to insert and drag the task's icon to the workflow canvas. In this example, we have selected
stonebranch-manualtask-01.
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Step 8  The Controller inserts stonebranch-manualtask-01 as a precedent to the Waiting stonebranch-timertask-02 task, and
stonebranch-manualtask-01 begins running (as a Manual Task, it requires a user action). When stonebranch-manualtask-01
completes, stonebranch-timertask-02 begins running.

o

stonebranch-timertask-01
Success
stonebranch-manualtask-01
Action Required
%f [ LT
' -_‘-_'_'_'_'_‘—'—-—-—._.1‘_ | i 1
N [| 1
I — 1
stonebranch-filemonitor-02 ! 1
Running Email Tutorial st

stonebranch-timertask-02

|

Email Tutorial
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Step 9  Once again, right click stonebranch-timertask-02 to display a menu of actions available for that task.

\C

stonebranch-timertask-01
Success

Running

/

stonebranch-filemonitor-02

Email Tutorial

\
— 0

$

stonebranch-manualtask-01

Action Required

"
n
[]

View/Edit

[|
stonebranch-tin

Commands 4

View PredecessorsiSuccessors

|

Insert Task As Predecessor..

Insert Task As

W4

Properties

Email Tutorial

Step 10 Select Insert Task As Successor.... The Task Insert > Task Selection dialog displays.

Task Inzert > Task Selection

=] (]

Task Name: =stonebranch-filemonitor-03

File Monitor j Search |

| Task Type

Tas

k Mame

1|

I i

Step 11 Find the task you want to insert and drag the task's icon to the workflow canvas. In this example, we have selected
stonebranch-filemonitor-03.
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Step 12 The Controller inserts stonebranch-filemonitor-03 as a successor to stonebranch-timertask-02. When
stonebranch-timertask-02 completes successfully, the inserted stonebranch-filemonitor-03 task begins running.

\C

stonebranch-timertask-01
Success

stonebranch-filemonitor-02
Running

/

stonebranch-manualtask-01
Action Required

—0
Email Tutorial _
stonebranch-timertask-02

stonebranch-filemonitor-03

|

Email Tutorial

For additional information, see:
® Finding a Task in a Workflow

® |nserting a Task in a Workflow
® Searching for and Adding Tasks
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Tutorial - Skipping, Unskipping, and Showing-Hiding Skipped Task
Instances

You can skip (and unskip) individual task instances and task instances within a workflow that have been launched but have not yet started to run.
For skipped tasks within a workflow, you can choose to show or hide those tasks in the Workflow Monitor.

You also can skip a task instance so that all dependent task instances of that task instance automatically are skipped as well.
Although there are several methods for skipping, unskipping, and showing/hiding skipped task instances, in this exercise we will:
® Skip a task instance in a workflow.

® Unskip a previously skipped task instance in a workflow.
® Show and hide a skipped task instance in a workflow.

. Note
There also are methods for skipping a task and showing/hiding a skipped task before it becomes a task instance (that is, before
it or the workflow in which it resides has been launched). See the links at the bottom of this page.

Step 1 From the Automation Center navigation pane, select Tasks > Workflow Tasks. The Workflow Tasks list displays a list of all workflow
tasks.

Step 2 Right-click Simple Workflow (created in the Creating a Simple Workflow tutorial), and on the Action menu, click Launch Task.
Step 3 On the Activity Monitor, select Active Workflow Task Instances from the drop-down list.

Step 4 Click Simple Workflow. The Workflow Monitor displays for this running workflow.
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Step 5 Right-click the Sleep3 task while it is in Waiting status and, from the pop-up menu that displays, click Commands / Skip.

*.  Note
If you wanted to skip the Sleep3 task and its dependent Sleep5 and Sleep6 tasks, you would click Commands / Skip
Path.
b
Opswise - Test Email
SUEIE 55
Sleepl
Fun E ing
] O
[m] .
Commands k Clear Dependencies
Sleep2 Sle Force Finizh
[} O Inzert Tazk As Predecessor... Hold
/ Inzert Task A% Successor.. ( Skip
Skip Path
Properties
Sleeph Sleepb

The Sleep3 status changes from Waiting to Skipped. When Sleepl completes successfully, Opswise Controller will skip Sleep3 and
start running Sleep5 and Sleep6.
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Step 6 To un-skip Sleep3, right-click it and, from the pop-up menu that displays, click Commands / Unskip.

Opswise - Test Email
Success

Sleep1
Comanc T

Insert Task As Predecessor...

Sleep?

Funning
Insert Task Az Successor..

Properties

1C)

Sleeph
Running

The task status changes from Skipped to Waiting. When Sleepl completes successfully, the Controller will not skip Sleep3.
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Step 7 To hide the skipped Sleep3 task in the Workflow Editor, right-click in the Workflow Monitor canvas and click Hide Skipped.

Opswise - Test Email
Success

O

Sleepi
Success

O

Commands
Sleep2 Sleep3 Show Skipped/Restore
Success Skipped Hide Skipped
\ Find In Graph...
Insert Task...
Sleeps Sleepf Properties

Success Success
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Step 8 To show the skipped Sleep3 task in the Workflow Monitor, right-click in the Workflow Editor canvas and click Show Skipped/Restore.

Opswise - Test Email
Success
Sleep

Success

Commands
Sleep2
Success Show Skipped/Restore
Hide Skipped
Find In Graph...
Ingert Task...
Sleepb Sleeph _ _
Success Success Properties

For additional information, see:

Skipping a Task

Unskipping a Task

Showing or Hiding Skipped Tasks

Adding Skip/Run Criteria for Specific Tasks
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Tutorial - Using Variables in a Simple Task

Introduction

Resolving Variable Using Value from Global Variable Table
Resolving Variable Using Value from Task

Resolving Variable Using Value from Trigger

Introduction

', Note
You need an Email Connection to perform this exercise.

In the Launching an Email Task Based on a File Monitor tutorial, a built-in variable called ${ ops_t ri gger _nane} and a system variable called
${ _dat e} were included to pass information into an Email message. Those variables were resolved using system information when the email
task instance was created.

In this exercise, we will create a new user-defined variable, use it in a task, and run the task both manually and via a trigger to illustrate how such
variables are resolved.

Resolving Variable Using Value from Global Variable Table

Step 1 Create a Variable with the following values:

®* Name = Tutorial
® Value = Global

Step 2 Click the Save button.

Variable Details | =118
[l save $€ Close

Variable

— Details

Mame : Tutorial Wersion : 1

Global

Value :

Description :

Member of
Business Senvices :

[l save & Close

Step 3 Create an Email task with the following values:

Task Name = Email Tutorial

Email Connection = your Email connection
To = your Email address

Subject = Variable demo

Body=${Tutorial}
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Step 4 Click the Save button.

Email Task Details

Email Tagk

—[ax
[ save 3% Close

|~

— General
Task Name : Email Tutorial

Task Description

Wember of
Business
Senices

Hold on Start: [7]

Virtual Resource
Priority

Version 1

Hold Resources on D
Failure

— Email Details

Email Template
Reply-To

dan.maran@stonebranch.com
To

Subject: Variable Demo

b E Email Connection : | QA-ORSWISE-MAILER

H{Tutorial}

Body

— Time Options

Late Start: [7]
Late Finish: [
Early Finish : [7]

User Estimated
Duration :

~ » ¥ | HH:MM:SS

[E] save ## Close

Step 5 Click the Launch Task button.

Step 6 You should receive an email with Global in the body of the email.

Resolving Variable Using Value from Task

Step 1 Open the Email Tutorial task and click the Variables tab.

Step 2 Click the New button to display Variable Details for a new Variable and enter the following values:

® Name = Tutorial
® Value* = Task
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Step 3 Click the Save button.

Variable Details Bl =1
[E] save 3£ Close
Variable
— Details
Mame : Tutorial
Task
Value :
Description :
] save £ close

Step 4 In the Email Tutorial Details, click the Update button and then click the Launch Task button.

Step 5 You should receive an email with Task in the body of the email.

Resolving Variable Using Value from Trigger

Step 1 Create a Time trigger with the following values:
® Trigger Name = Variable Demo

® Tasks = Email Tutorial
® Time = (Five minutes from the present time.)

Step 2 Click the Save button.

| Time Trigger Details: Variable Demo =3[ %
v [E] Update (&) Enable (&) Trigger Now List Qualifying Times . [F) Copy ¢ Delete | & Refresh 3§ Close

Time Trigger Variables Versions

— General
Name : Variable Demo Version : 2
Description :

Member of
Business Senvices

Calendar : System Default » E Time Zone : | System (US/Eastern) ")

Email Tutorial

Task(s) : -

— Status
Forecast: [] Status ;| Disabled
Skip Count : 0
Skip Trigger if
Active : 0
Simulate : — System Default — »
— Time Details
Time Siyle : Time v
Time: [16 |w [ |15 |» |HH:MM
— Day Details
Day Style : Simple w
@ Daily © Business Days  Specific Day(s)
— Restrictions

Special Restriction : [7]

[E] update 4 Enable (&) Trigger Now List Qualifying Times... [y copy ] Delete % Refresh 3 close
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Step 3 Re-open the Variable Demo trigger and click the Variables tab.

Step 4 Click the New button to display Variable Details for a new Variable and enter the following values:

®* Name = Tutorial
® Value* = Trigger

Step 5 Click the Save button.

Variable Details -2
[l save $& Close
ariable
— Details
Mame : Tutorial
Trigger
Value :
Description :
[E] save # Close

Step 6 In the trigger Details, click the Update button and then the Enable button.

Step 7 You should receive an email with Trigger in the body of the email.

For additional information, see:

® User-Defined Variables
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Tutorial - Using Variables in a Workflow

1. Note
You need a working Database Connection for this tutorial.

For tasks executing within a Workflow, the order of precedence for resolving user-defined variables differs.

As the following procedure demonstrates, the variable definition in the task takes precedence, then Opswise Controller looks within the Workflow
or parent Workflow(s), with the global variable coming last.

Step 1 Create a SQL task called SQL with Variable with the following SQL command:

CREATE TABLE ${tutorial }${_date("yyyyMwd",5) } (name varchar(128), val ue varchar(128));

Step 2 Click the Save button and then re-open the task.
Step 3 Click the Variables tab and create a Variable with the following values:
® Name = tutorial
® *Value+ = task
Step 4 Click the Save button and in the task Details, click the Update button.
Step 4 Create a Workflow called Variable Workflow.
Step 5 Add the SQL With Variable task to the Workflow and save it.

Step 6 Launch Variable Workflow. and open the SQL With Variable task instance on the Activity Monitor. Note that the SQL command
resembles the following, with the value from the task variable.

CREATE TABLE t ask20090913 (nanme varchar(128), val ue varchar(128));

Step 7 Open the task and delete the task variable.

Step 8 Go back to Variable Workflow and add the following variable:

tutorial /workfl ow

Step 9 Open the task instance. The SQL command used the variable from the workflow because the task no longer had a variable.

CREATE TABLE wor kf | ow20090913 (nane varchar(128), val ue varchar(128));

For additional information, see:

® User-Defined Variables
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Tutorial - Creating Custom Days and Periods

Introduction

Create a Custom Day

Create a Custom Period

Assigning Custom Day and Custom Period to a Calendar
Selecting a Custom Calendar for a Trigger

Introduction

In this tutorial, we will create a Custom Day and period for a Calendar, and assign that Calendar to a Trigger.

Create a Custom Day

In this procedure, we will create a Custom Day, which can be applied to any Calendar.

Step 1 From the Automation Center navigation pane, select Other > Custom Days. The Custom Days list displays.
Step 2 Click the New button to display Custom Day Details for a new Custom Day and enter/select the following values:

Name = Thanksgiving

Holiday is enabled

Type = Relative Repeating Date
When = 4th

Day of Week = Thu

Month = Nov

Step 3 Click the Save button.

Custom Day Details ==
[El save # Close
Custom Day
— Details -
Hame : Thanksgiving Wersion : 1
Description :
Period: []
Holiday: []
Type ! |Relative Repeating Date i
When : | 4th %3
Day Of Week: | Thy .
Manth - Nov v
[] save 3 Close

Create a Custom Period

In this procedure, we will create a custom period of days, which can be applied to any calendar.

Step 1 Click the New button on the Custom Days list and to display Custom Day Details for a new Custom Day and enter/select the following
values:

® Name = 4th Quarter

® Period is enabled.

® Type = List of Dates

® Dates = 2014-10-01 and 2014-12-31.
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Step 2 Click the Save button.

Custom Day Details - | (2]
[l save $£ Close
Custom Day
— Details
Hame : 4th Quarter Wersion : 1
Description :
Period :
Type : |List of Dates ¥
@ e
Dates “
Dates :
2014-10-01
2014-12-31
[E] save # Close

Assigning Custom Day and Custom Period to a Calendar

In this procedure, we will assign the custom day and custom period to a new Calendar.

Step 1 From the Automation Center navigation pane, select Other > Calendars. The Calendars list displays.

Step 2 Click the New button to display Calendar Details for a new Calendar and enter/select the following values:

® Name = Custom Calendar #1

Step 3 Click the Save button.

Calendar Details

Calendar

Details

—3lx
[E] save 3 close

Name : Custom Calendar #1 Version 1

Description :

Member of
Business
Services
Business

Days - Sunday [ Monday Tuesday Wednesday Thursday Friday Saturday [

[F] save

3 Close

Step 4
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Step 5 Click the Edit button to display an Edit Members pop-up dialog of all Custom Days.

Edit Members | |=] | s
kd Custom Calendar #1

Name “ = Name N
stonebranch-customday-01 Ath Quarter
stonebranch-customday-02 Thanksgiving
stonebranch-customday-03
=tonebranch-customday-04
stenebranch-customday-05 |j|

L«

[»]

[«]

Save Cancel

Step 6 Select Thanksgiving and 4th Quarter, and then click the Save button. Those two Custom Days now appear on the Custom Days list
for Custom Calendar #1.

Calendar Details: Custom Calendar #1

Calendar Custom Days Triggers Versions

2 Calendar Custom Days Mew Edit =

Custom Day Description Period Holiday Updated By Updated
[E] Thanksawing No  No ops.admin 2014-07-29 13:44:23 0400
[E] ath Quarter Yes  No ops.admin 2014-07-29 13:44:23 0400

Step 7 In the Calendar Details, click the Update button.

1. Note
You also can assign a Custom Day to a Calendar by clicking the Calendars tab in the Custom Day Details.

Selecting a Custom Calendar for a Trigger

In this procedure, we will assign the custom calendar to a trigger.

Step 1 From the Automation Center navigation pane, click Triggers > Time Triggers. The Time Triggers list displays.
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Step 2 Click the New button to display Time Trigger Details for a new Time Trigger and enter/select the following values:

Name = Custom Trigger

Calendar = Custom Calendar #1

Task(s) = (any task)

Day Style = Complex

Date Noun = Thanksgiving (a Custom Day created for Custom Calendar #1)

Step 3 Click the Save button.

Time Trigger Details: Custom Trigger ] ||=] [ B8
v [F] Update &, Enable (&) Trigger Now List Qualifying Times... [y Copy ¢ Delete |5 Refresh 3 Close

Time Trigger Variables Versions

— General
Mame: Custom Trigger Version : 2
Description :

Member of
Business Semnvices :

Calendar : |Custom Calendar #1 v [j Time Zone ;| System (US/Eastern) v

stonebranch-windowstask-01

il

Taskis):

— Status
Forecast: [0 Status - |Disabled
Skip Count: 0

Skip Trigger if
Active =

Simulate : |— System Default— v

— Time Details
Time Style : | Time »

Time: |00 |» | |00 |w  HH:MM

— Day Details
Day Style : |\ Complex )
Date Adjective : |Every ")

Date Noun : |Thanksaiving v

Diate Qualifier : Year v

Date Adjustment : |Mone ¥

— Restrictions
Special Restriction : []

[] update &\ Enable (%) Trigger Now List Qualifying Times... Ly copy 6 Delete 5| Refresh # close
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Step 4 Re-open Custom Trigger and click the List Qualifying Times button to see that the trigger will run the task every year on

Thanksgiving.
Qualifying Times = || =[5
Custom Trigger
E Listing From: Tuesday, July 28, 2014 13:55:15 EDT -0400 @

UserTrigger Timezone: US/Eastern

Thursday, Movember 27, 2014 00:00:00 EST -0500
Thursday, Movember 26, 2015 00:00:00 EST -0500
Thursday, Movember 24, 2016 00:00:00 EST -0500
Thursday, November 23, 2017 00:00:00 EST -0500
Thursday, Movember 22, 2018 00:00:00 EST -0500
Thursday, Movember 28, 2019 00:00:00 EST -0500
Thursday, Movember 26, 2020 00:00:00 EST -0500
Thursday, November 25, 2021 00:00:00 EST -0500
Thursday, Movember 24, 2022 00:00:00 EST -0500
Thursday, Movember 23, 2023 00:00:00 EST -0500
Thursday, Movember 28, 2024 00:00:00 EST -0500
Thursday, November 27, 2025 00:00:00 EST -0500
Thursday, Movember 26, 2026 00:00:00 EST -0500
Thursday, Movember 25, 2027 00:00:00 EST -0500
Thursday, Movember 23, 2023 00:00:00 EST -0500
Thursday, Movember 22, 2029 00:00:00 EST -0500
Thursday, Movember 28, 2030 00:00:00 EST -0500
Thursday, Movember 27, 2031 00:00:00 EST -0500
Thursday, Movember 25, 2032 00:00:00 EST -0500
Thursday, November 24, 2033 00:00:00 EST -0500
Thursday, Movember 23, 2034 00:00:00 EST -0500
Thursday, November 22, 2035 00:00:00 EST -0500
Thursday, Movember 27, 2036 00:00:00 EST -0500
Thursday, November 26, 2037 00:00:00 EST -0500
Thursday, Movember 25, 2038 00:00:00 EST -0500
Thursday, Movember 24, 2039 00:00:00 EST -0500
Thursday, Movember 22, 2040 00:00:00 EST -0500
Thursday, Movember 28, 2041 00:00:00 EST -0500
Thursday, Movember 27, 2042 00:00:00 EST -0500
Thursday, Movember 26, 2043 00:00:00 EST -0500
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Step 5 Inthe Custom Trigger Details, change the following values:

® Date Noun = Business Day.
® Date Qualifier = 4th Quarter (a Custom Day period created for Custom Calendar #1)

Step 6 Click the Update button.
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Step 7 Re-open Custom Trigger and click the List Qualifying Times button to see that the trigger will run the task every business day
during the custom period, October 1 to December 31.

Qualifying Times = /|| 3|3

Custom Trigger

E Listing From: Tuesday, July 28, 2014 140706 EDT -0400 @

UserTrigger Timezone: US/Eastern

Wednesday, October 01, 2014 00:00:00 EDCT -0400
Thursday, October 02, 2014 00:00:00 EDT -0400
Friday, October 03, 2014 00:00:00 EDT -0400
Maonday, October 06, 2014 00:00:00 EDT -0400
Tuesday, October 07, 2014 00:00:00 EDT -0400
Wednesday, October 08, 2014 00:00:00 EDT -0400
Thursday, October 09, 2014 00:00:00 EDT -0400
Friday, October 10, 2014 00:00:00 EDT -0400
Monday, October 13, 2014 00:00:00 EDT -0400
Tuesday, October 14, 2014 00:00:00 EDT -0400
Wednesday, October 15, 2014 00:00:00 EDT -0400
Thursday, October 16, 2014 00:00:00 EDT -0400
Friday, October 17, 2014 00:00:00 EDT -0400
Maonday, October 20, 2014 00:00:00 EDT -0400
Tuesday, October 21, 2014 00:00:00 EDT -0400
Wednesday, October 22, 2014 00:00:00 EDT -0400
Thursday, October 23, 2014 00:00:00 EDT -0400
Friday, October 24, 2014 00:00:00 EDT -0400
Manday, October 27, 2014 00:00:00 EDT -0400
Tuesday, October 28, 2014 00:00:00 EDT -0400
Wednesday, October 29, 2014 00:00:00 EDCT -0400
Thursday, October 30, 2014 00:00:00 EDT -0400
Friday, October 31, 2014 00:00:00 EDT -0400
Manday, Movember 03, 2014 00:00:00 EST -0500
Tuesday, Movember 04, 2014 00:00:00 EST -0500
Wednesday, Movember 05, 2014 00:00:00 EST -0500
Thursday, Movember 06, 2014 00:00:00 EST -0500
Friday, Movember 07, 2014 00:00:00 EST -0500
Monday, Movember 10, 2014 00:00:00 EST -0500
Tuesday, Movember 11, 2014 00:00:00 EST -0500
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For additional information, see:
® Triggers Overview

® Creating Calendars
® Creating Custom Days
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Tutorial - Generating Forecast Data

In this exercise, we will:

® Add a workflow and its tasks to the Forecast calendar.

® Run the workflow and display its forecast information.

® Update a task in the workflow and then re-run the workflow.
® Recalculate the forecast information for the workflow.

Step 1 Create a Time trigger and enter/select the following values:

Name = Simple Workflow Trigger.
Task(s) = Simple Workflow
Forecast = enabled

Business Days = enabled

Time Trigger Details: Simple Workflow Trigger = | [=]] B4
v ] save & Close
Time Trigger Wariables Versions
— General
Hame : Simple Workflow Trigger Version : 1
Description :
Member of ”
Business Senvices :
Calendar : | System Default ¥ D Time Zone : | System (US/Eastern) »
Simple Workflow
=)
Task(s): =
— Status
Forecast: Status - |Disabled
Skip Count : 1]
Skip Trigger if
Active o
Simulate : |- System Default - .
— Time Details
Time Style : Time .
Time: |00 |w| |00 |+ |[HHNMM
— Day Details
Day Style : | Simple w
" Daily % Business Days { Specific Day(s)
— Restrictions
Special Restriction : [7]

[E] save 3 Close

Step 2 Save the trigger and then enable it. A trigger must be enabled in order to generate forecast data for it.
Step 3 From the Automation Center navigation pane, select Triggers > Forecast Calendar. The Forecast Calendar identifies Simple

Workflow on the days in the forecast period, for the current month, when it will be launched by Simple Workflow Trigger. (By default,
tasks within a Workflow are not displayed.)
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[ Home [ “ Forecast Calendar [ ]
4a Apr 2015
Sun Kon Tue Wed Thu Fri Sat
1 2
3 4 5 [} 7 8 9
12:00am Simple Workflow 12:00am Simple Werkflow 12:00am Simple Werkflow 12:00am Simple Werkflow 12:00am Simple Workflow
10 " 12| 13 14 15 16
12:00am Simple Workflow 12:00am Simple Workflow 12:00am Simple Workflow 12:00am Simple Workflow 12:00am Simple Workflow
17| 18 19 20 21 2 23
12:00am Simple Workflew | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
24/ 25 26/ 7 28 28 30
12:00am Simple Workflew | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow | 12:00am Simple Workflow
S S S
12:00am Simple Workflow

Step 4  Click any Simple Workflow link in the Forecast Calendar to display a Forecast Details pop-up. Note that the Launch Time and End
Time are identical; since the workflow has never been run, there is no data to support estimated times.

Forecast Details =|=|[>%

|w Close|

Forecast " Child Forecast ]

Details

Task | Simple Warkfiow =] Trigger : |Simple Workflow Trigger =]

Task Type | Workliow | Launch Time : [2014-08-18 00:00:00 -0400 |

Waorkflow : | =] End Time : [2014-08-18 00:00:00 -0400 |

BusinessMSeemml')ceg;r REL:';IuCErlittiE:a |Rur‘| ‘
Simulation: []

3 close |
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Step 5  From the Automation Center navigation pane, select Triggers > Forecasts. The Forecasts list identifies Simple Workflow and every
task in Simple Workflow, as well as their Launch Times and End Times, for every day in the forecast period when Simple Workflow
will be launched by Simple Workflow Trigger.

Home Forecasts
“ 31 Forecasts Custom Filter — pone — ~ | S Filter. =
Trigger Task Task Type Workflow Launch Time * End Time Run Criteria Evaluation Simulation Updated By
D Simple Workflow Trigger ~ Simple Workflow Workflow 2014-08-04 00:00:00 -0400  2014-08-04 00:00:00 -0400  Run No ops.admin -
I:I Simple Workflow Trigger  Timerd Timer Simple Workflow — 2014-08-04 00:00:00 -0400  2014-08-04 00:00:10 -0400  Run No ops.admin =
D Simple Workflow Trigger — TimerS Timer Simple Workflow  2014-08-04 00:00:00 -0400  2014-08-04 00:00:00 -0400 Run No ops.admin
D Simple Workflow Trigger  Timer2 Timer Simple Workflow  2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin
D Simple Workflow Trigger  Timer3 Timer Simple Workflow  2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin
D Simple Workflow Trigger  Timerd Timer Simple Workflow 2014-08-04 00:00:10 -0400  2014-08-04 00:00:21 -0400 Run No ops.admin
D Simple Workflow Trigger  TimerS Timer Simple Workflow  2014-08-04 00:00:20 -0400  2014-08-04 00:00:31 -0400 Run No ops.admin
I:I Simple Workflow Trigger  Timer1 Timer Simple Workflow  2014-08-05 00:00:00 -0400  2014-08-05 00:00:10 -0400 Run No ops.admin
D Simple Workflow Trigger ~ Simple Workflow Workflow 2014-08-05 00:00:00 -0400  2014-08-05 00:00:00 -0400  Run No ops.admin
I:I Simple Workflow Trigger  Timer§ Timer Simple Workflow  2014-08-05 00:00:00 -0400  2014-08-05 00:00:00 -0400 Run No ops.admin
I:I Simple Workflow Trigger — Timerd Timer Simple Workflow — 2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400  Run No ops.admin
D Simple Workflow Trigger  Timer2 Timer Simple Workflow  2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400 Run No ops.admin
D Simple Workflow Trigger  Timer3 Timer Simple Workflow  2014-08-05 00:00:10 -0400  2014-08-05 00:00:21 -0400 Run No ops.admin
D Simple Workflow Trigger  TimerS Timer Simple Workflow  2014-08-05 00:00:20 -0400  2014-08-05 00:00:31 -0400 Run No ops.admin
D Simple Workflow Trigger  Timer§ Timer Simple Workflow  2014-08-06 00:00:00 -0400  2014-08-06 00:00:00 -0400 Run No ops.admin
T E— = = T -
Vv Forecast Details

Step 6  Re-display the Time Triggers list, right-click Simple Workflow Trigger, and then click Trigger Now to launch Simple Workflow.

Step 7 When Simple Workflow has completed, re-display the Time Triggers list, right-click Simple Workflow Trigger, and then click
Recalculate Forecast.

*,  Note
You also can recalculate the forecast by right-clicking Simple Workflow on the Workflow Tasks list and then clicking
Recalculate Forecast.
Step 8  Re-display the Forecast Calendar and click any Simple Workflow link in the Forecast Calendar to display a Forecast Details pop-up,
which now contains estimated Launch Time and End Time information based on the Workflow run just completed.
Forecast Details =|[=][%
# Cclose
Forecast Child Forecast
Details
Task : | Simple Workflow D Trigger : | Simple Workflow Trigger D
Task Type : |Workflow Launch Time : | 2014-08-11 00:00:00 -0400
Workflow : D End Time : 2014-08-11 00:02:21 -0400
Member of Run Criteria o
Business Services : Evaluation :
Simulation : [7]
3 Close
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Open the Timer Task and change the Time in Seconds value from 10 to 50, and then click Update.

Step 9
Timer Task Details: Timer2 0| =1 g
v [ Update [} Launch Task & View Parents LT Copy ¢ff] Delete |4 Refresh § Close
Timer Task Variables Actions Virtual Resources | Mutually Exclusive Instances Triggers Notes. Versions
— General
Task Name : Timer2 Version : 7
Task Description
Member of -
Business Senices
Hold on Start: [
Virtual Resource 1 - Hold Resources on =
Priority Failure :
— Timer Details
Timer Type : | Seconds %3
Wait Time in 5
Seconds:
— Time Options
Late Start: [7]
Late Finish: []
Early Finish: []
User Estimated v v v HHMNSS
Duration
— Statistics
First Time Ran | 2015-04-06 15:03:09 -0400 "”WES“”ST‘?m”ZE_ 30 Seconds
Last Time Ran | 2015-04-06 15:03:09 -0400 Average '”S‘T‘?m”ze_ 30 Seconds
Last Instance 20 Seconds H\ghestlnst_ancg 20 Seconds
Duration Time :
Number of 1
Instances
[E] Update | [5) Launch Task| |[gy View Parents Cry copy i Delete 5| Refresh # Close

Step 10 Re-run Simple Workflow.

Step 11 When Simple Workflow has completed, re-calculate its Forecast; since the updated time for the Timer1l task affected the Simple
Workflow End Time (the time it took to run the Workflow), the Forecast information for Simple Workflow is now obsolete.

Step 12 Re-open the Forecast Calendar and click any Simple Workflow link to see that 20 seconds has been added to the End Time.

For additional information, see:
® Creating and Maintaining Workflows

® Triggers Overview
® Displaying Trigger Forecast Information
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Tutorial - Setting Up a Virtual Resource

In this exercise, we will set up an imaginary resource and three imaginary tasks.

In this scenario, two of our tasks are resource-intensive, and they run on the same machine. Therefore, if one is already running when the other is
launched, we want the second task to wait until the first is finished before running. However, our third task is not so resource-intensive, so we will
allow this one to run at the same time as either of the other two.

To simplify the exercise, we will use Timer tasks.

Step 1  From the Automation Center navigation pane, click Other > Virtual Resources. The Virtual Resources list displays.
Step 2 = Click the New button to display an empty Virtual Resource Details and enter the following values:

® Resource Name = Resource A
® Resource Limit=5

Step 3 Click the Save button.

=[O %

[E] save $E Close

Virtual Resource Details

Virtual Resource

Details
Resource Name : Version : 1
Resource Type : |Renewable v Resource Limit : 10
Resource
Description :

Member of -
Business Services :

Resource Used: 0

[E] save 3 Close
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Step 4 Update the Timerl, Timer2, and Timer3 tasks that you created in the Creating a Simple Workflow tutorial.

For Timerl:

1. Change Time in Seconds to 60.

2. Click the Virtual Resources tab to display the Virtual Resources list for Timerl:
a. Click the Edit button, add Resource A to the Virtual Resources list, and click Save.
b. Click the Details icon for Resource A to display its Task Virtual Resource Details.

Task Virtual Resource Details

Task Virtual Resource

Task: |Timer1
Virual Resource : |Resource A

Amount : 1

[F] update o Delete

% Refresh

(=21 (=51

& close

=0

[ Update ] Delete |5 Refresh 3 Clos

c. Change the Amount (number of resource units required from the virtual resource) from 1 to 4 and click the Update but

For Timer2:

1. Change Time in Seconds to 30.

2. Add Resource A and change the Amount to 4.

For Timer3:

1. Change Time in Seconds to 20.

2. Add Resource A and keep the Amount at 1.

Step 5 Open Resource A and click the Tasks tab to see that Timerl, Timer2, and Timer3 are listed.

Virtual Resource Details: Resource A

Virtual Resource Tasks Currently In Use By

3 Task Virtual Resources
Task =
Timer1

Timer2

(5 (&1 [

Timer3

Outstanding Reguests

Versions

Amount Updated By
4 ops.admin
4 ops.admin

1 ops.admin

Edit =
Updated =
2014-08-12 10:31:15 -0400
2014-08-12 10:31:49 -0400
2014-08-12 10:42:32 -0400

Step 6 Create a Time Trigger called Trigger A, and select Task1, Task2, and Task 3 in the Task(s) field, and enter a Time three minutes from
current time.
Step 7 Click the Save button, right-click Trigger A on the Triggers list, and click Enable.
Step 8 When the trigger is satisfied, only Timerl or Timer 2 will run, along with Timer3. When Timerl or Timer 2 finishes, the other will run run.
Display the Activity Monitor and note that Timerl or Timer 2 is waiting in Resource Wait status.
Home Activity
--|Last48 hours - [ No quick filter = | Custom Filter|— Mone — v | g Filter.
Instance Name Type Status Invoked By Start Time End Time Updat ™
D Timer3 Timer Success Trigger: Trigger A 2014-08-12 10:56:00 -0400  2014-08-12 10:56:10 -0400  2014-08-
D Timer1 Timer Resource Wa Trigger: Trigger A 2014-08-1
D Timer2 Timer Running Trigger: Trigger A 2014-08-12 10:56:00 -0400 2014-08-
Step 9 In the Virtual Resource Details, click the Currently In Use By tab and observe which tasks are running on this virtual resource. Note tha
this display does not automatically refresh.
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For additional information, see:

Virtual Resources
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Tutorial - Creating a Widget

There are three types of Widgets, all of which can be placed on one or more Dashboards:
® System
® Activity
® Report
In this exercise, we will create an Activity Widget that identifies any failed task instances in the past week.

(You cannot create, modify, or delete a System Widget; they are provided by the Controller.)

Step 1 From the Reporting navigation pane, select Widgets. The Widgets list displays.
Step 2 Click the New button and then click Activity Widget. An Activity Widget Details pop-up displays.
Step 3 Enter / select the following values:

Name = Failed

Refresh Rate (Seconds) = 900 | 15 minutes
Status(es) = Failed

Time Constraint = Last week

Composite Color = Red

Activity Widget Details =|Oollx
[l save 3 Close
Activity Widget

| =

— General

Name : Failed Widget Type : | Activity
Description -

Refresh Rate (Seconds) :|900 | 15 minutes ~

— Details

Time Contraint : Last week ~

Composite Color : #FFpnoo !

Status(es) : Failed

Mo items to show.

Composite Status(es) :

© B BIE =

[E] save 3 close

Step 4 Click the Save button. This Widget can now be added to any Dashboard and can be selected for any Composite Widget.

For additional information, see:

® Widgets
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Tutorial - Creating a Dashboard and Adding Widgets

Creating a Dashboard and Adding Widgets

Opswise Controller provides a default Dashboard containing multiple Widgets that displays as the Home Dashboard when you log in to Opswise
Controller.

You can create your own Dashboards containing any available Widgets.

In this exercise, we are going to create a Dashboard and select Widgets for the Dashboard.

Step 1 = Click the Home icon in the top right corner of any page to display the Home dashboard.

|‘ Dashboards [ ‘

System Details
[Agents: 18/5000] [Triggers: Unlimited] [Tasks: Unlimited]

L

Active Task Instances By Status

L

R [Days: 7/368]

MNode 1d: qa-op: 6:8080-ga_op: 6b238
Node Mode: Active

MNode Uptime: 2 Days 21 Hours 55 Minutes 33 Seconds
Node Time: 2014-08-18 15:43:34 -0400

Release: 6.1.0.0

Build: build_238

Build Date: 08-15-2014_0336

Database Type: MYSQL

Database Name: ga_opswisebb238

Database URL: Jdbe:mysql-//ga-dfdb2._stone_branch/
Database Connections:  In Use: 0, Total: 5

Memory Maximum: 989.88 MB

Memory Used: 155.81 MB (15.74%)

Memoary Free: 834.06 MB (584.26%)

Lo

Agent Status Cluster Hode Status 2 OMS Server Status

L

W offine (9) B Active (9) I Active (1) I Connected (1)

‘\ Administrater's Home ” Dashboard #2 " Dashboard #3 | | ' Refresh | | Customize -

Step 2  On the Customize drop-down list at the bottom of the Home Page, click New.

Step 3 Select a name for the new Dashboard on the New Dashboard pop-up and click OK. A new, empty Dashboard displays.
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Step 4 From the list of Widgets to the left of the Dashboard, drag and drop any of the Widgets into either column. (If you want to add more
columns, click either Column Properties drop-down list and then click Add Column.)

s Column Properties - Column Properties -
@ select a Widget
@ spacer [ Active Task Instances By Status | [ Active Task Instances By Type x|
e Active Instances
s Active Task Instances By Status Deﬁ1ed
Waiting
@Y Activs Task Instances By Type Held
e Agent Status Undeliverable
Runnin
@) Cluster Node Status P ind
@) Held/Action Required R Start Failure
@) Ous Server Status Cancelled
Failed
s Pending
e Problem
Ri ~
g unning Agent Status
Skipped
s SuccessiFinished
@)  system Details
@) Task Activity Status
[ Workflow (8) I Timer (25) Il z/0S (6)
M offine (8) I Active (9) M File Transfer (1)
l Admi o Jl C D Jl New D J save || @ Cancel || @ Hide WidgetPicker || Cusiomize -

Step 5 After you have added Widgets to your new Dashboard, you can click the x icon in the top right corner of any Widget to remove it from
the Dashboard, or drag and drop any Widget to a new location in the Dashboard.

o 0| owmores 0

e Select a Widget... Column Properties - ‘Column Properties -
@ Spacer [ Active Task Instances By Type x| [ Cluster Node Status x|
@ Active nstances
@ Active Task Instances By Status
@Y Active Task Instances By Type
@ Agent Status
@ Cluster Node Status
@) Heldiaction Reguired
@Y OMS Server Status
@ Pending [ Workflow (8) [ Timer (25) [l z/0S (6)

@5 Problem . File Transfer (1)
& funning Active Task Instances By Status ‘
@ skipped
@) successiFinished Defined
@Y zystem Details Waiting

Held
@) Task Activity Status Undeliverable

Running

Running/Problems

Start Failure

Cancelled

Failed

Agent Status x|
B offline (8) Bl Active (9) B Active (1)
D J{ [ o Jl New D J save || @ Cancel || @ Hide WidgetPicker || Cusiomie ~
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Step 6 Click the Save button to add the Dashboard.

For additional information, see:

® Home Dashboard
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Tutorial - Creating Business Services

Business Services are used to group records into business functions.

In this exercise, we will create two hypothetical Business Services: Tech Support and Operations.

Step 1 From the Administration navigation pane, select Security > Business Services. The Business Services list displays.

Step 2  Click the New button to display an empty Business Service Details.

Step 3  Enter the following values:

® Name = Tech Support

® Description = This is the Tech Support business service.

Step 4 Click the Save button.

Business Service Details

Business Service

—|E|*
[E] save ¥ Close

Details

Name: Tech Support

Description © This is the Tech Support business senvice.

[E] save 3£ Close

Step 5 Repeat steps 2 to 4 for a Business Service called Operations.

For additional information, see:

® Business Services
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Tutorial - Assigning Records to Business Services

In this exercise, we will assign the Timer and Simple Workflow tasks created in the Creating a Simple Workflow tutorial to the Operations
Business Service, and the SQL task and Bigger Workflow tasks created in the Running a Workflow with a Conditional Path tutorial) to the Tech

Support Business Service.

See the Creating Business Services tutorial to see how these Business Services were created.

Step 1 Open the Timer task called Timer1, which you created in the Creating a Simple Workflow tutorial.

Step 2 From the Member of Business Services drop-down list, select Tech Support and Operations.

Timer Task Details: Timer1

=[O X

[ Update (=) Launch Task |55 View Parents [ Copy ¢ Delete | Refresh 3£ Close

Timer Task Variables Actions Virtual Resources | Mutually Exclusive Instances Triggers. Notes. Versions
— General
Task Name : Timer1 Version : 1
Task Description :
Member of
Business Services : Ogrztmns, IECh Support hs
. Accounting
Haold on Start : 0T
Virtual Resource Operations
Priority: | [7] QA Deparment
[] stonebranchbusinessservice 01 —
— Timer Details [7] stonebranchbusinessservice 02 —
) ) stonebranchbusinessservice 03
TimerType | 7] stonebranchbusinessservice 04
Time in Seconds - | | Stonebranchbusinessservice 05
Tech Support
— Time Options
Late Start: []
Late Finish : [7]
Early Finish : [0]
User Estimated v v | Hrnss
Duration :
[E] Update &y View Parents Cr copy ci] Delete 4| Refresh 3 Close

Step 3 Click the Update button.

Step 4 Repeat steps 1 to 3 for the Timer2 and Timer3 tasks and the Simple Workflow Workflow, all of which you also created in the

Creating a Simple Workflow tutorial.

For additional information, see:

® Business Services
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Tutorial - Viewing Activity by Business Service

® |ntroduction

Introduction

In this exercise, we will launch the Simple Workflow Workflow (created in the Creating a Simple Workflow tutorial and, on the Activity Monitor,

display only tasks assigned to the

Operations Business Service (see Assigning Records to Business Services|Tutorial - Assigning Records to Business Services] tutorial.

Step 1 Run the Simple Workflow Workflow.

Step 2 Display the Activity Monitor, which will list the Simple Workflow and all of its tasks.

Home

868 Task Instances
Instance Name ™
Timer§

Timer5

Timerd

Timer3

Timer2

Timer1

s s s s e

Simple Workflow

Reports [

Business Services []

Type
Timer
Timer
Timer
Timer
Timer
Timer

Workflows

Activity £
+|Last48 hours «
Status

Success

Success

Success

Success

Success

Success

Success

[E No quick filter ~

Invoked By

Custom Filter — Mone —

Start Time

Workflow: Simple Workflow 2014-08-11 14:53:25 -0400

Workflow: Simple Workflow 2014-03-11 14:53:25 -0400

Workflow: Simple Workflow 2014-08-11 14:53:14 -0400
Workflow: Simple Workflow 2014-08-11 14:53:14 -0400

‘Workflow: Simple Workflow 2014-08-11 14:53:14 -0400
Workflow: Simple Workflow 2014-08-11 14:53.04 -0400

Manually Launched

2014-08-11 14:53:04 -0400

End Time
2014-08-11 14:55:25 -0400
2014-08-11 14:53:35 -0400
2014-08-11 14:53:24 -0400
2014-08-11 14:53:

5 -0400
2014-08-11 14:54:04 0400
2014-08-11 14:53:14 -0400
2014-08-11 14:55:25 -0400

v | S Filter...

Updated

2014-08-11 14:55:25 -0400
2014-08-11 14:53:35 -0400
2014-08-11 14:53:25 -0400

2014-08-11 14:53:25 -0400
2014-08-11 14:54:05 -0400
2014-08-11 14:53:14 -0400
2014-08-11 14:55:25 -0400

Step 3 Apply the following Filter to the list of tasks:

136 /

®* Member of Business Services

® contains
® QOperations

The Activity Monitor now displays only tasks assigned to Operations Business Service.

Home

668 Task Instances
Instance Name ™
Timer3

Timer2

Timer1

5 s s

Simple Workflow

Reports [

Business Services [1]

Type
Timer
Timer
Timer

Workflow

Activity [
-|Last48 hours «
Status

Success

Success

Success

Success

[E No quick filter ~

Invoked By

Custom Filter |- Unsaved 2 -

Start Time

Workflow: Simple Workflow 2014-08-11 14:53:14 -0400

Workflow: Simple Workflow 2014-08-11 14:53:14 -0400

Workflow: Simple Workflow 2014-08-11 14:53:04 -0400

Manually Launched

2014-08-11 14:53:04 -0400

End Time
2014-08-11 14:53:25 -0400
20714-08-11 14:54.04 -0400
2014-08-11 14:53:14 -0400
2014-08-11 14:55

5 -0400

|| Fiter.. |

Updated
2014-08-11 14:53:25 -0400
2014-08-11 14:54:05 -0400
2014-08-11 14:53.14 -0400

2014-08-11 14:55:25 -0400

-
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Tutorial - Creating a Report

In this exercise, we will create a report for Widgets.

Step 1 From the Reporting navigation pane, select Reports. The Reports list displays.

Step 2

Step 3 Click the Save button.

® Title = All Widgets
® Table = Widgets (ops_widget)
® Field(s) = (pre-selected fields that display when you click *Edit Fields)

In the empty Report Details below the list, enter / select the following values:

A

v

Home Reports [
Custom Filter — None — v | @ Filter.. [E GoTo.. | &
Report Details H Save [] New
Report
— General
Title : All Widgets Visible To: |Me w
Type - |List v
Table : | Widgets (ops_widget) -
— List Fields and Ordering
Field Title Field Title Order
Name
No order
Widget Type
Description
Field(s) : \updated By SortBy:
Updated

Edit Fields... Edit Sort...
— Filter
& Match Al ' Match Any Advanced..
+J
[£] save ] Mew

Step 4 Click the Run button to run the report, which displays under a new tab.
Dashboards [ | Reports [ | Al'Widgets report £
14 Widgets =
Name Widget Type Description Updated By Updated
E| Skipped Activity Activity - Skipped ops.admin 2014-07-17 11:57:25 -0400
Ii‘ Problem Activity Activity - Problem ops.admin 2014-08-12 15
E Success/Finished Activity Activity - Success/Finished ops.admin 2014-08-07 17:13:39 -0400
Ii‘ Task Activity Status Activity Task Activity by status ops.admin 2014-08-18 23:28:05 -0400
E Failed Activity ops.admin 2014-08-11 13:43:50 -0400
Ii‘ Agent Status System Pie chart for agent statuses. ops.system 2014-06-24 20:00:00 -0400
El Held/Action Regquired Activity Activity - Held/Action Required ops.admin 2014-07-17 11:41:46 -0400
E| Cluster Node Status System Pie chart for cluster node statuses. ops.system 2014-06-24 20:00:00 -0400
EI OMS Server Status System Pie chart for OMS server statuses. ops.system 2014-08-24 20:00:00 -0400
El System Details System Displays a number of system details including version, database, and memory information. ops.system 2014-08-24 20:00:00 -0400
EI Pending Activity Activity - Pending ops.admin 2014-07-17 11:56:45 -0400
Ifl Running Activity Activity - Running ops.admin 2014-07-17 11:38:20 -0400
EI Active Task Instances By Status System Bar chart for active task instances grouped by task instance status. ops.system 2014-08-24 20:00:00 -0400
El Active Task Instances By Type System Bar chart for active task instances grouped by task instance type. ops.system 2014-08-24 20:00:00 -0400
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Step 5 Return to the Report Details and select the following Filter for the report:

* Widget Type

® equals
® Activity
Home [0} | Reports [ | AllWidgets []
~ Custom Filter|— None — v | 5% Filter.. [E GoTo.. | &
% Report Details [E] update [=] new [5] Save s . fflj Run ¢ Delete [ Refresh
Report
Title : All Widgets Visible To : |Me ¥ =
Type : |List - -
Table : | Widgets (ops_widget) -
— List Fields and Ordering
Field Title Field Title Order
Name
No order
Widget Type
Description
Field(s) : updated By Sort By
Updated
Edit Fields... Edit Sort...
— Filter
' Match Al Watch Any Advanced
(& |Widget Type | lequals | | Activity ")
+ ]
[7] Update | ] Mew ] save As... dli Run (& Delete 5| Refresh B
Step 6 Click the Update button, and then click the Run button to display the report under a new tab.
Dashboards [] | Reports [ | All'Widgets report ]
& Widgets =
Name ‘Widget Type Description Updated By Updated
E Skipped Activity Activity - Skipped ellen.ulrich 2014-07-17 11:57:25 -0400
If‘ Problem Activity Activity - Problem ops.admin 2014-08-12 15:54:55 -0400
If‘ Success/Finished Activity Activity - Success/Finished ops.admin 2014-08-07 17:13:39 -0400
If‘ Task Activity Status Activity Task Activity by status ellen.ulrich 2014-08-18 23:28:05 -0400
li‘ Failed Activity ops.admin 2014-08-11 13:43:50 -0400
If‘ Held/Action Required Activity Activity - Held/Action Required ellen.ulrich 2014-07-17 11:41:46 -0400
E| Pending Activity Activity - Pending ellen.ulrich 2014-07-17 11:56:46 -0400
E| Running Activity Activity - Running ellen.ulrich 2014-07-17 11:38:20 -0400

For additional information, see:

® Reports
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Tutorial - Creating a Report Based on Business Services

In this exercise, we will create two Activity reports so that users from our hypothetical Operations and Tech Support departments (see the
Creating Business Services tutorials) can view activity related to their organizations.

Step 1 From the Reporting navigation pane, select Reports. The Reports list displays.
Step 2 Click the New button to display empty Report Details.
Step 3 Enter/ select the following values:

® Title - Business Services

® Table = Business Services (ops_generic_group)
® Field(s) = (pre-selected fields that display when you click the Edit Fields button)

Step 4 Click the Save button.

Home [ | Reports [
~ Custom Filter|— Mone — v | 5% Fitter.. [E] CoTo.. | &
~ Report Datails [El save [T] New

Report

— General
Title : Business Senices Visible To : | Me v

Type : List .

Table : Business Services (ops_generic_group) -

— List Fields and Ordering

Field Title Field Title Order
Hame

Mo order
Description
Updated By

Field(s) : Updated SortBy:

Edit Fields... Edit Sort..

— Filter
% Match Al © Match Any Advanced..

W

E] save ] New

Step 5 Click the Run button. A Business Services report displays under a new tab.

Dashboards [] | Reports [] | Business Services report [

5 Business Services E{_:‘
Name Description Updated By Updated o

E| stonebranchbusinessservice 02 ops.admin 2014-06-13 15:19:47 -0400

E| stonebranchbusinessservice 03 ops.admin 2014-06-13 15:19:51 -0400

E| stonebranchbusinessservice 05 ops.admin 2014-06-13 15:20:00 -0400

E| stonebranchbusinessservice 01 ops.admin 2014-06-13 15:19:37 -0400

El stonebranchbusinessservice 04 ops.admin 2014-06-13 15:19:56 -0400
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For additional information, see:

®* Reports
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Tutorial - Creating Users and Assigning Roles and Permissions

® [ntroduction
® Create New Users
® Assign Permissions to Groups of Users

Introduction

In this exercise, we will create some users related to the Operations and Tech Support departments created in the Creating Business Services
tutorial.

We also will assign access and management rights via user roles and Opswise Controller permissions:
® Roles are pre-defined groups of permissions that control access to users, reports (filters), gauges, bundles, and promotions.

® Permissions control who can add, change, delete and control Controller tasks, task instances, triggers, Agents, calendars, and
credentials.

Create New Users

In this exercise, we will create a new user and assign different permissions to it.

Step 1 = From the Administration navigation pane, click Security > Users. The User list displays.
Step 2  Click the New button to display empty User Details for a new user and enter / select the following values:

User Id = userl
First Name = User
Last Name = One
Password = 123

User Details: User One i =1{k3
v [ Update () Delete |5 Refresh &£ Close
User User Roles Member of Groups Permissions
— Details
Userld: userl Time Zone : | System (USiEastern) ~
Password : Title : v
First Name : User Department :
Middle Mame : Manager : - D
LastMame: One Business Phone :
Email : Mabile Phone

Password Re;:;:ts B Web Egzvss:r _ System Default— .
Locked Out: ] Comma‘\ncgeLEl'r;e. — System Default— 9]
Active We:i?:g‘? — System Default— ~

[£] update il Delete & Refresh 3 close

Step 3  Click the Save button, log out of the Controller and then log in as userl.

Step 4  Click on several areas of the user interface. Since userl has not been assigned any permissions, userl can view only a limited
number of lists and records, and cannot create, modify, or delete any records.

Step 5  Log out of the Controller and log in as ops.admin.
Step 6  Open the userl record and click the User Roles tab.

Step 7  Click Edit.
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Step 8

Step 9
Step 10
Step 11

Step 12

Move the ops_admin role to the Roles List and click Save to provide userl with full administrative permissions.

Edit Members

Name *

ops_agent_cluster_admin
ops_bundle_admin
ops_dba
ops_email_admin
ops._fiter_global
opz_fiter_group
ope_imex
ops_multi_update
ops_prometion_admin
ops_report_admin
ops_report_global
ops_report_group
ops_report_publish
ops_report_schedule

ops_report_widget_create

Collection

4

s

-

Save

Roles List

groupa
Name “

ops_admin

Cancel

Type = Task
Create = enabled
Read = enabled
Update = enabled

Member of Business

Commands = Launch
Unassigned to Business Service = disabled

Click the User tab and then click the Update button.

Services = Tech Support

Log out and log back in as userl to verify that userl has the same permissions as ops.admin.
Log out and log back in as ops.admin, open the userl record, and remove the ops.admin role.

Click the Permissions tab, click the New button, and in the Permissions Details select the following values:

Permission Details

Permission

[E] Update (52 Delete

=A%

4 Refresh 3 Close

— Details
Type:
Create
Read:
Update :
Delete :
Commands :
Name :

Member of Any Business
Senvice or Unassigned:
Member of Business
Services :

Task
O

Launch

*

]

Unassigned fo Business Bl
Senvice :

Tech Support

[El update

i) Delete

## Close

%| Refresh

Step 13  Click Save, log out of the Controller, and log in as user1.

Step 14 userl now will be able to see the tasks assigned to the Tech Support group, and launch those tasks. However, userl cannot see
them on the Activity Monitor because userl was not given permissions on Task Instances.
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Assign Permissions to Groups of Users

In this exercise we will assign our last user to a group, then assign permissions to the group instead of to the user.

Step 1 Open the userl record .

Step 2 Click the Member of Groups tab to display a list of groups that userl belongs to.

Step 3 Click the New button to display Group Details for a new group.

Step 4 In the Name field, enter Groupl, and then click the Save button. The Member of Groups list now shoes Groupl.
Step 5 Open Groupl and click the Permissions tab to display the list (currently empty) of permissions for Groupl.
Step 6 Click the New button and on the Permissions Details, enter / select the following values:

Type = Task Instance

Read, Update, Delete = enabled

Commands = All

Business Services = Operations
Unassigned to Business Service = disabled

These permissions provides all users in the Group1 full permissions on all activity (task instances) related to the Operations Business
Service. Any users you assign to Groupl will inherit these permissions.

Permission Details =||=|[%

[E] save 3£ Close

Permission

— Details

Type : |Task Instance »
Read:
Update :
Delete :
Commands : |ALL w
Name: *

Member of Any Business A Unassigned to Business
Senvice or Unassigned : Senvice ©

a

Member of Business Operations -

Senvices :

[E] save 3£ Close

Step 7 Click Save, log out, and then log in as userl to check the permissions.

For additional information, see:

® Users and Groups
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Tutorial - Creating User Groups and Assigning Permissions

In this exercise, we will create users and user groups, then assign permissions to the groups instead of directly to the users.

Step 1 Create the following three users:

® stonebranch-user-01
® stonebranch-user-02
® stonebranch-user-03

Step 2 Select Users > Groups and create a group called stonebranch-group-01.

1. Click the Permissions tab
2. Click the New button and add the following permission:
® Type = Task Instance
® Read = enabled
® Member of Any Business Service or Unassigned = enabled
3. Click the Group Members tab and click Edit.
4. Add stonebranch-user-01 to the group.

Step 3 Create a group called stonebranch-group-02.

1. Add the following two permissions:
® Type = Task Instance
Read = enabled
Update = enabled
Commands = None
Business Services = stonebranchbusinessservice 01
Unassigned to Business Service = disabled

and

Type = Task Instance

Read = enabled

Update = enabled

Commands = All

Business Services = stonebranchbusinessservice 02
Unassigned to Business Service = disabled

Group Details: stonebranch-group-02

Group Group Roles | Group Members | Child Groups || Permissions

2 Opswise Permissions

Type Operations. C: Name L i to Busin: Service Busin Services Updated By
D Task Instance Read, Update ALL = Mo stonebranchbusinessservice 02 ops.admin
D Task Instance Read, Update = MNo stonebranchbusinessservice 01 ops.admin

Updated
2014-08-07 16:12:04 0400
2014-08-07 16:08:14 -0400

2. Click the Group Members tab and Edit button to add stonebranch-user-02 to the group.
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Step 4 Create a group called stonebranch-group-03.

1. Add the

following two permissions:

Type = Trigger

Create = enabled

Read = enabled

Update = enabled

Delete = enabled

Commands = None

Member of Any Business Service or Unassigned = enabled

and

Type = Task

Create = enabled

Read = enabled

Update = enabled

Delete = enabled

Commands = None

Member of Any Business Service or Unassigned = enabled

Group Details: stonebranch-group-03

Group Group Roles | Group Members | Child Groups | Permissions

2 Opswise Permissions

Type Operations. Commands. Name Unassigned to Business Service  Business Services
El Task Create, Read, Update, Delete = es =
El Trigger Create, Read, Update, Delete * es *

Updated By
ops.admin

ops.admin

Updated
2014-08-07 16:18:42 0400
2014-08-07 16:18:32 0400

#la

2. Add stonebranch-user-03 to the group.

Step 5 Log in as each user and note that each is limited to those functions assigned to the user's group.

For additional information, see:

® Users and Groups
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